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Energy Commission nor has the Commission passed upon the accuracy or
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PREFACE

This style manual is intended to assist California Energy Commission staff, advisors,
and others who prepare Energy Commission papers, reports, and presentations.

If you have been awarded a contract to prepare a consultant report for the Energy
Commission, please see Publication Number CEC-180-2015-XXX, Style Manual (Third
Edition) for Preparing Contract and Consultant Reports for the California Energy
Commission.

If you are conducting technical research that results in an interim or final report for the
Energy Research and Development Division, please do not use this style manual.
Instead, please use the Energy Commission report Style Manual (Third Edition): For
Preparing Energy Research and Development Technical Research Project Reports, Energy
Commission Publication Number CEC-180-2015-XXX.

The most recent version of this manual and templates for use with Microsoft Word® are
located on the Energy Commission “EnergyNet” intranet website at
http://energynet/Exec/doc_production/index.html.

This link works only internally on the Energy Commission “EnergyNet” intranet. The
information is not available to the public on the Internet.

If you are not sure these guidelines apply to your report, paper, or presentation or if you
have any questions about the information provided in this manual, please phone the
Media and Public Communications Office at (916) 654-4989.


http://energynet/Exec/doc_production/index.html
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ABSTRACT

This report is the third edition of the manual of style to be used in writing reports and
papers for the California Energy Commission to ensure that those reports and papers
use Energy Commission-approved style. This report also contains directions and
guidelines for preparing presentations given by Energy Commission staff.

The goal of this document is to encourage report writers to draft clear and concise
documents that conform to the Energy Commission-approved format. This edition
clarifies the use of references and includes shorter synonyms for phrases that add
clutter to prose.

This document, based upon The Gregg Reference Manual, Eleventh Edition, is available
online with links from the Energy Commission “EnergyNet” intranet website. Microsoft
Word® files for the document templates, covers, and credits pages can be downloaded
from those pages as well. Templates for presentations are also available on EnergyNet.

The Media and Public Communications Office may revise this document as necessary.
Please check for the latest version at http://energynet/Exec/doc_production/index.html.

This link works only internally on the Energy Commission “EnergyNet” intranet.

Keywords: California Energy Commission, plain language, formatting, usage, executive
summary, abstract

Please use the following citation for this report:

Aldrich, Bob, Susanne Garfield, Margaret Larkin, Lana McAllister, Carol E. Robinson,
Michael Wilson. 2015. Style Manual: Third Edition. California Energy Commission.
Publication Number: CEC-180-2015-XXX.
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EXECUTIVE SUMMARY

Many government agencies, colleges and universities, and organizations have style
manuals to ensure that documents produced by and for those entities conform to a
certain style in formatting and prose. The third edition of the California Energy
Commission’s style manual encourages staff writers to produce a consistent-looking
document while outlining the Commission’s policies and successes in energy
sustainability in plain language.

The audience for California Energy Commission reports includes the Commissioners,
state agencies, the Legislature, the Governor’s Office, energy stakeholders (such as
utilities, energy service providers, solar and wind energy producers), the media, and
ratepayers. All have a vested interest in learning about and understanding the
Commission’s functions and roles in promoting sustainable energy resources and
addressing climate change.

The font styles have changed since the last two editions. Furthermore, a fifth heading
level has been added; however, when organizing a report, please limit the number of
headings to four.

Other changes from the previous edition include the following:

e The list of acronyms in the chapter “Preparing Consistent, Accurate Reports and
Report Content Styles” has expanded. These acronyms can be used on
subsequent references in the abstract and executive summary of an Energy
Commission report

e The Editing Unit added a chapter on citations. The style manual will follow The
Chicago Manual of Style, 16th Edition.

e In the “Glossary” section, the manual writers request that not only must an
acronym be spelled out, but defined.

e The “References” subsection has been expanded to include sample reference
notes based upon The Chicago Manual of Style, 16th Edition.

The bases for this style manual are The Gregg Reference Manual, Eleventh Edition; The
Chicago Manual of Style, 16th Edition; and the EIA Writing Style Guide. Any issues not
covered in this style manual may be found in these references. Other resources used for
this style manual edition include the Merriam-Webster Dictionary, To the Point: A
Dictionary of Concise Writing by Robert Hartwell Fiske, and The Elements of Style by
William Strunk Jr. and E. B. White.

Plain Language

Both California and federal governments mandate the use of plain language in the
documents they produce. According to PlainLanguage.gov, plain language (or “plain
English”) is communication your audience can understand the first time they read or

1
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hear it. Plain language uses short sentences; the active voice rather than the passive
voice; common, everyday words; and logical organization.

Clarity and Conciseness

As mentioned, Chapter 7 on Word Usage has been expanded to include simpler
synonyms and terms for technical terms and jargon. If you must use jargon, please
explain it for a broader audience.

Preparing Energy Commission Reports

Staff members preparing a report for the Energy Commission should consult this style
manual before and while writing their report. The “Document Production and Notices”
link on the Commission’s EnergyNet intranet page has resources, including report
templates, that can help writers prepare documents. Staff members who have additional
questions may contact Commission chief editor Carol Robinson at 654-5015 or the
Media and Public Communications Office at 654-4989.



CHAPTER 1:
What This Manual Is About

Hard writing makes easy reading.

— Wallace Stegner

Introduction

The California Energy Commission produces several hundred presentations, reports,
brochures, and other printed items each year. These publications! are used to convey
information at public meetings, are printed and sent to libraries, and must be placed on
the Energy Commission website (http://www.energy.ca.gov).

The Energy Commission management believes that all material the agency produces
should properly reflect its image and identity including name, seal, logos, Governor and
Energy Commissioner names, and other relevant information. This principle is not to
suggest that all printed documents be identical in appearance; however, all documents
need to have a consistent design; be grammatically consistent, clear, and concise; and
have an instant identity with other materials the Commission has prepared.

As an author, you have the opportunity to demonstrate skill, creativity, and pride in
your work as well as an obligation to meet the expectations of your audience and the
Energy Commission. Readers should be able to rely on consistent, professional quality -
regardless of the subject matter.

Energy Commission Media and Public Communication Office staff understands that you
need to know what is expected to produce a quality report, presentation, brochure, or
other material. This style manual clarifies the approved style conventions at the Energy
Commission, including information on the approval process, and formatting a
Commission report or paper. One chapter is devoted to writing, including strategies for
organizing a document; editing sentences for conciseness and clarity, grammar,
punctuation, mechanics, and proofreading. Chapter 10 deals with presentations that
Energy Commission staff may make public.

It is not the Energy Commission’s intention to create an entire grammar text or one that
teaches a person how to write. Rather, staff wants to address the items that seem most
vexing to staff and other writers. For a complete and comprehensive source, the Energy

1 The terms "publications” and “documents” are used interchangeably throughout this manual to refer to
Energy Commission reports, papers, brochures, flyers, handouts, presentations, and all other types of printed
and delivered materials.



Commission recommends that each office purchase and use the Gregg Reference
Manual, Eleventh Edition.

Presentations

If a member of the Energy Commission staff is giving a presentation or speech at a
conference, giving testimony at a legislative or other governmental hearing, or speaking
at another gathering, that presentation or speech must be made available on the
Commission website. Office managers, division chiefs, and occasionally a committee
member or adviser review these types of presentations. If the meeting is of high enough
public visibility, the Executive Office may ask to review the presentation or speech
before it is given.

Presentations given at Energy Commission workshops or hearings are also placed on the
website - usually on the documents page for that proceeding. Usually only office
managers and division chiefs review these types of presentations.

You can find more about creating a good presentation in Chapter 10.

Why Should You Use This Style Manual?

By using this style manual, you will ensure that Energy Commission documents look
consistent and will be acceptable. All Energy Commission staff should use this Style
Manual for reports and presentations.

This document replaces all previous Energy Commission publications, memos, and
directives regarding report style and document conventions.

Using this manual will help you meet the needs of your audience and achieve your
purpose because the style manual is based on the latest efforts of the Media and Public
Communications Office.

Above all, using this style manual will free you from making decisions about formatting
and writing style so that you can concentrate on the more creative elements of writing,
the content of a document - the important work that you do best.

There are legal grounds for “good writing.” California Government Code Section 6219
says:

6219. (a) Each department, commission, office, or other administrative agency of
state government shall write each document that it produces in plain,
straightforward language, avoiding technical terms as much as possible, and using a
coherent and easily readable style. (b) As used in this section, a “state agency
document” means any contract, form, license, announcement, regulation, manual,
memorandum, or any other written communication that is necessary to carry out the
agency responsibilities under the law.

Furthermore, public funds pay for the reports produced by the Energy Commission.
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Hence, the public deserves the best document for its money. It deserves reports, papers,
or presentations that are clear and well-written.

Updates to the Style Manual

The style manual is a working document. The Media and Public Communications Office
staff has tried to make it current; however, language, styles, and technologies change.
The staff will regularly review this manual and incorporate any necessary changes into
future editions.

The Media and Public Communications Office encourages your creative comments and
constructive suggestions on improving the clarity of this manual and making it easier
for you to use. Please contact Carol Robinson, the Energy Commission chief editor, at:

Media and Public Communications Office
1516 Ninth Street, MS-29

Sacramento, California 95814

Phone: 916-654-4989

E-mail: mediaoffice@energy.ca.gov

Major Updates Since Last Edition

There have been some major and minor changes throughout the style manual correcting
errors and amending content. The following are the main updates that have changed
since the previous edition.

e The cover no longer has the watermark of the old Energy Commission logo. The
color version of the new logo, however, is on the bottom left of the cover.

e The style manual has expanded the section on references, which borrows from
The Chicago Manual of Style, 16th Edition.

¢ The font style for the text and headings has been changed. See Table 1 for the
full listing of font and sizes to be used throughout all reports.

e The Commission has changed the requirement that blank pages need to be
inserted at the end of chapters or after certain parts (acknowledgments, preface,
abstract). This change will reduce the amount of paper being used in reports.
Blank pages, however, still should be inserted after the following pages so that
the next section begins on the right-hand side.

o Following single-page acknowledgements page.

o Following table of contents, list of figures, and list of tables.

o Following executive summary (if used).

o Insert a blank page so that Chapter 1 always begins on the right-hand

side.
e The abstract should be on an odd-numbered, right-hand-facing page.

Do not put blank pages after the cover or credits page. The credits page is now the

5



backside of the cover. Do not put blank pages at the end of chapters so that the next
chapter begins on the right side.

e Additional items have been added to the “Word Use and Misuse” section, Chapter
7.



CHAPTER 2:
Report Contents, Formatting, and Styles

Report Contents

All California Energy Commission reports should contain the following sections, in the
following order:

e Cover page (required)

o (redits page on the reverse side of cover (required) with legal disclaimer
(mandatory on Lead Commissioner and staff reports)

Acknowledgements page (optional)

Preface (optional)

Abstract, keywords and citation page (required)

Table of Contents (required, followed by List of Figures and List of Tables, if
needed)

Executive summary (optional but required on policy documents)

Body of the report

References (if applicable)

Glossary/Acronyms (If more than 10 acronyms or abbreviations are used, it is
required.)

Bibliography (if applicable)

e Appendices (if applicable) (Create a separate volume if very large.)

e Attachments (if applicable)

See Chapters 4 and 5 for a detailed discussion of report contents and parts.

Report Templates

Once the report is written, you must format it using the Commission-approved styles.
Energy Commission staff must use the report typographic styles described in this
manual. They are summarized later in Table 1: Formatting Style Matrix for Reports.
The style template and boilerplate cover and credits page templates are on the Energy
Commission “EnergyNet” Intranet website at:

http://energynet/Exec/doc_production/index.html

All Energy Commission computers should be set up to have the Commission style
formats as the default in Microsoft Word. All other styles can be stripped from the Word
formatting palette. If a report has been written elsewhere, it may need to be reformatted
using the Commission styles.

For formatting help, please see the step-by-step instructions on EnergyNet at:

http://energynet/Exec/doc_production/formatting/index.html

7
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Blank Pages

Blank pages should be inserted after the following pages so that the next section begins
on the right-hand side.

e Following single-page acknowledgement page.
e Following table of contents, list of figures, and list of tables.
e Following executive summary (if used).

Do not put blank pages after the cover or credits page. The credits page is the backside
of the cover. Do not put blank pages at the end of chapters so that next chapter begins
on the right side. Please make sure the abstract is on an odd-numbered, right-hand-
facing page.

Figures, Graphs, and Tables

Figures, graphs, and tables (graphics) should be clear and readable. Source lines are
required on all figures and graphs.

The graphic should be introduced in the paragraph before and explained fully. Do not
download and use low-resolution graphics from the Internet, such as in Figure 1. While
these may appear fine on your computer monitor, when printed, the picture may look
blurry.

Figure 1. Low-Resolution Graphic Downloaded From Internet

[ ENERGY COMMISSION
Example of logo downloaded from Energy Commission website and enlarged for effect. Graphics

or photos used on the Internet are typically done as 72 or 96 dots per inch (dpi) graphics files.
Most reports are printed at 300 dpi. So, the graphic will appear very blurry when printed.

Source: California Energy Commission, Media and Public Communications Office

The title or label of a figure, graphic, or table should be typed in as part of the report
and not part of the graphic. The reason is that the graphic may have to be resized to fit
the page. If the label is part of the graphic, the size of the label will change depending
on the resizing of the graphic.

The figure title should use the “Figure Titles” style in Arial, 10 pt., bold, centered similar
to the example on the previous page or in Figure 2 below. Fonts used within figures,
graphs, and tables can be either serif or sans-serif as long as that font presents the
information clearly and is readable. Most, however, use a sans-serif font like Arial or



Helvetica for the information in figures, graphs, or tables.

Captions or sources listed below a figure, graph, or table should use the style specified
in the formatting matrix (Arial, 10 pt.). Captions and sources should also be separate
from the figure or table and not embedded in the graphic file because of accessibility
issues.

If used, the list of figures and list of tables should be automatically generated in a
manner similar to the table of contents. If a figure or table title is particularly long,
hand-edit it in the list of figures/list of tables as you see fit.

Original graphics files (for tables, charts, and so forth) must be submitted with your
report. (See Chapter 11.) If a chart or graph was created in Excel, then that Excel file
should also be submitted with the report.



Figure 2: Example of a Graphic Properly Used in a Report

: i 2 7. ) ‘ = J | -
SOLARA is the first apartment community in California to be fully powered by the sun and is the
first project delivered under the California Energy Commission New Solar Homes Partnership

Program.
Photo Credit: Community HousingWorks, developer/owner of SOLARA.

Use of Colors in Graphs and Figures, Size of Fonts, and Other Graphic
Elements

Many times the Energy Commission’s reports are photocopied in black and white.
Therefore, it is important to use colors in charts, graphs, and figures that will reproduce
well on a photocopy machine. Plan your document for future readers who may see your
chart as a black-and-white photocopy. You want the information to be clear and easy to
understand; the numbers should be large and clear enough to be read.

Moreover, graphs, and figures may need to be reduced in size to fit on a page within the
text. Make sure the font size in the graphic is large enough to be read if the graphic is
shrunk in size.

Graphics or figures should be created at a minimum of 300 dots per inch.

Footnotes

Use footnotes (not endnotes) in Energy Commission reports.2 Use them sparingly to
briefly clarify terms or concepts that the average reader may not understand. Place
footnotes at the bottom of the page on which they appear. Do not place footnotes at the
end of a section.

2 The footnote number appears in the text as a superscript; the footnote is at the bottom of the page.
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Insert footnotes using Word footnote feature: Insert > Reference > Footnote. Footnote
numbering should automatically readjust as footnotes are added or deleted* Enter
footnotes after periods or commas.

Do not use footnotes in report or chapter titles, and do not footnote headings or
subheadings. Moreover, please do not use footnotes in the preface, abstract, or
executive summary.

Page Breaks

If a subheading appears at the bottom of the page, but the text jumps to the next page,
put a page break before the subheading. Font metrics may be slightly different
depending on the computer operating system. Including a page break will ensure that
headings are not left alone at the bottom of a page with no content.

Pagination
Use Lucida Bright 10 pt. for page numbers, centered at the bottom of each page.

Pagination begins on the acknowledgements or preface page (as a Roman numeral - i, ii,
iii...) and continues in lowercase Roman numerals through the abstract, table of
contents, and lists of figures and tables (if used). The cover and credits pages are not
numbered. Number the blank pages but do not put "This Page Intentionally Left Blank"
on blank pages.

On the first page of the executive summary (or Chapter 1 if there is no executive
summary), begin numbering in Arabic numeral (1, 2, 3...) and continue sequential
numbering throughout the document. See Chapter 5 for page numbering of those
sections.

Table of Contents, List of Figures and Tables

The table of contents should be generated automatically using Microsoft Word pull-
down menu: Insert > Reference > Index and Tables feature. (Appendices or attachments
must be added manually.) The table of contents is based on the style headings assigned
to each section. Check the table of contents to make sure it has been updated correctly
after each series of edits. Check that chapters and headings agree with the page
numbering should be the last task before creating the Adobe Acrobat PDF or printing

3 Microsoft Word will automatically superscript the footnote number at the bottom of the page. The footnote
reference should be in Lucida Bright 8 pt., as shown in these examples. Use Footnote Text style for the
footnote itself. Do not add an extra space between footnotes; the spacing is built into the style.
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the final master copy for reproduction. See Figure 8 for an example of a table of
contents.

Report Formatting Styles

The Energy Commission has changed the typeface and size of fonts to use when
creating reports in Microsoft Word. The following is a summation of the styles that are
used in all Energy Commission reports. Exceptions to this include the final Integrated
Energy Policy Report and some other specialized reports. Those exceptions must be
cleared through the Media and Public Communications Office in advance of the design
and layout.

The rationale behind the change is striking a balance between having a concise page
count and having Commission documents be enhanced for maximum readability and
reduction of eye strain. Lucida Bright is a highly readable typeface that meets the need
of the new report format and works with any version of Microsoft Word® on both PCs
and Apple Macintosh® computers.

While aesthetics were a consideration in the changes made to the templates, the main
goal was improved functionality. The old templates used an overly wide column width
for the type point size, which resulted in more characters per line than is recommended
by design standards for readability. The new typeface for the templates is a compromise
between achieving the optimal line length and keeping the page count to a minimum.

Table 1. Summary of Formatting Styles for Energy Commission Reports

Body (Normal) Text Lucida Bright, 10 pt. leading over 15 pt.
leading, with 7 pt. spacing at the end of
the paragraph, align left.

Bullets (regular and numbered) Lucida Bright, 10 pt., 0.2-in. hanging indent
Acknowledgments, Preface, Abstract, Table | Lucida Bright, 15 pt., BOLD,
of Contents, List of Tables of Figure CENTERED, ALL CAPS

Heading

Heading 1 (Chapter Titles) L“Cida Bright, 20 pt-,
Bold, Aligned Left

Heading 2 (Subheading) Lucida Bright, 15 pt., Bold,
Aligned Left

Heading 3 (Sub-subheading. Please use as | Lucida Bright, 12 pt., Bold Over 15

subheading for executive summary) Pt. Leading, Aligned Left
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Heading 4 (Sub-sub-subheading. Please use
as sub-subheading for executive
sumimary.)

Lucida Bright, 10 pt. Bold Over 15 Pt.
Leading, Aligned Left

Heading 5 (Sub-sub-sub-subheading. Use
very sparingly.)

Lucida Bright 10 pt., Italics Over 15 Pt
Leading, Aligned Left

Figure and Table Titles

Arial 10 pt., Bold, Centered

Caption Text

Arial, 8 pt., bold, align margins with figure
margins.

Credits for Photos and Source Information

Arial 8 pt., normal

Credit: Text Goes Here.

Source: California Energy Commission, Media and Public Communications Office

The following formatting style matrix provides a more comprehensive description of the

approved style formats.

Table 2: Formatting Style Matrix for Energy Commission Reports

Use for all “regular”

text that is not Align left
assigned a special Spacing at single
style (e.g. heading, line,

bullet, caption, etc.)
paragraph
Space 7 pt. after
paragraph

Line Spacing 15 pt.

Space O pt. before

Style Type Definition Example
Normal Lucida Bright Lucida Bright
10 pt. (10 pt.)

The quick, fast fox jumped over the
lazy, brown dog.

Appendix Text Same as Normal

The quick, fast fox jumped over the
lazy, brown dog.
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Attachments

The Energy
Commission does
not require that its
style format be
used in documents
that are

not applicable

attachments.
Body Text See “Normal” above
Bullets Lucida Bright e Bullet item number 1

11 pt.

Space O pt. before
bullet

Space o pt. after
bullet

Text Indent 0.2"
Additional level
bullets are each
indented another
0.2"

e Bullet item number 2
o Item number 2a
o Item number 2b
= Sub-bullet to
2b

Follow last bullet with two hard
returns to separate from next
paragraph.
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Captions

Arial bold, 8 pt.

Align left; indent to
align with image

Space 6 pt. before
paragraph; space 7
pt. after paragraph.

Caption should be
the width of the
graphic. Brief
captions are
preferred; however,
some graphics may
require a lengthier
caption. Typically,
captions should not
introduce new
information. Please
use only high-
resolution
photographs of 150
to 300 dots per
inch (dpi). Don’t
use 72 dpi photos
or graphics
“borrowed” from
websites. A source
line is required on
all graphics,
including graphs,
photos, and tables.

Figure 3: BiPV on Carport

Building-integrated solar photovoltaic roofing
materials used in a carport by Solar Utility of
Culver City, California.

Photo Credit: United Solar Systems Corporation

Credits for Photos
and Source
Information

Arial normal 8 pt.,
align margins with
table margins

Source: California Energy Commission
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Equations

Use special
characters if
necessary.

Center on new line.

Every equation
presented must be
referred to and
explained in the
text.

You can use
Equation Editor in
Microsoft Word to
create the equation.

If special
characters are used
to create the
equation, however,
make sure
typefaces are
supported and
available across
various computer
operating systems
or platforms.
Occasionally,
special characters
may not be
available in a
standard typeface.

E=mc?

Co,
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Figure and Table
Titles

Arial bold, 10 pt.
Align center.

Space 12 pt. before
paragraph; space 0
pt. after paragraph.

Text in Figure Title
case.

Colon after the
figure/table
number and before
title.

Figures and tables
can be numbered in
a chapter number
format (Figure 2-1,
Table 2-3, etc.) or
numbered
sequentially
throughout the
entire report. Be
consistent through
the entire
document. Do not
mix formats.

Figure XX: This Is an Example

Note: Title is in title case with no
period at the end of the title unless it
is a complete sentence.
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Figures, Graphs,
Charts, Drawings,
Photographs

Figures should be
centered. Align
captions with left
edge of figure.

Avoid the use of
Word text boxes
wherever possible
and insert the
figures directly into
the document.

Every figure
presented must be
referred to in the
text.

If the figure is a
graphic, picture or
photograph, it
should be at least
300 dots per inch
(dpi). Do not use
low-resolution
Internet pictures
(72 to 96 dpi).

For an example, see Figure 1 on page
12.

Footnotes

Lucida Bright
normal 8 pt.

Align left.

Space 0O pt. before
paragraph, space 5
pt. after paragraph.

For an example of a footnote, see page
7.
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Graphs

Do not title a graph
while it is being
created in separate
software, such as
Microsoft Excel.
The figure title
should label the
graphic. The
author, however,
should strive for
clarity.
« Please label all
axes.
« Use sentence

case.
« Include units.

Make sure point
size is at least 14
pt. on all labels.

Glossary

Use a table with the
word and acronym
or abbreviation in
the left column,
and the definition
in the right column.

Do not show the
gridlines of the
table. Do not use
multiple tabs to
“create” a table, but
use the Word table
function.
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Heading 1

Lucida Bright, bold,
20 pt.

Align left

Space O pt. before
paragraph, space
24 pt. after
paragraph.

Page break before
paragraph.

% pt. border below
text, not
underlined.

CHAPTER 1:
This Is Heading 1

Heading 2

Lucida Bright, bold,
15 pt.

Line spacing 15 pt.
Align left.

Space 12 pt. before
paragraph, space 2
pt. after paragraph

This Is Heading 2

Heading 3

Lucida Bright bold
12 pt.

Line spacing 15 pt.
Align left.

Space 10 pt. before
paragraph, space 2
pt. after paragraph

This Is Heading 3

Heading 4

Lucida Bright bold
10 pt.

Line spacing 15 pt.
Align left
Space 10 pt.

This Is Heading 4

Heading 5

Lucida Bright italic,
10 pt.

Line spacing 15 pt.
Align left.

Space 0 pt. before
paragraph, space 2
pt. after paragraph

This Is Heading 5, which is to be used
sparingly.
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Page Numbers

Palatino Linotype
10 pt.

Centered

Bottom of page

See bottom of this page for an
example.

References -
Bibliography

Normal style
0.25" Hanging
Indent

This is an example of a reference that
goes into a second line. The
hanging indent approximates the
end of the first last name.

Table Column
Headings and Table
Data Cells

Arial or Lucida
Bright

Columns Heads -
Bold

Data cells - No Bold

Size depends on
amount of data in
cell. Don’t crowd
cells.

Title for following
sections:
Acknowledgements,
Preface, Table of
Contents, Abstract,
and Executive
Summary

Lucida Bright
Bold

15 pt.

All uppercase
Centered

Space 0 pt. before
Space 12 pt. after

Note: Use a soft
return to break the
title into neat and
easier-to-
understand
segments.

This is the Title Style
For the Sections
Mentioned on the Left

Source: California Energy Commission, Media and Public Communications Office
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CHAPTER 3:
Publication Steps for
Papers, Reports, and Presentations

Reports and Papers

Before beginning, you should understand how the Energy Commission publication
process works. It essentially breaks down into three areas (see Table 1 on next page):
1) Steps 1 through 7 are generally prereview.
2) Steps 8 through 20 reflect the general steps for document review.

3) Steps 21 through 26 involve publishing a report and distributing final master
copies.

Review this Style Manual at the beginning of the writing process and follow the format
and styles in your Commission reports.

California Energy Commission staff should use the latest version of the Publication
Approval Form (CEC Form 5) available on the Commission “EnergyNet” Intranet at:

http://energynet/Exec/doc_production/templates/

The Energy Commission has additional steps for mass reproduction of documents. Ten
copies or fewer may be duplicated using an office or division photocopier. For amounts
greater than 10 copies, a reproduction order must be made with the Reprographic Unit
in Business Services.

Table 1: California Energy Commission
Report and Paper Creation, Review, and Publication Steps

Preplan and conceptualize the report. Determine target audience and scope.

Outline and plan chapters and sections.

Author(s) write draft of report.

Author(s) edit draft of report, adds cover and credits pages, creates Table of
Contents, and formats report using Energy Commission style template.

Author(s) sends draft of report to office manager (and peers) for first review.

Office manager adds comments and suggestions.

(Note: Report will probably go back and forth between the author[s] and their
manager or colleagues several times before finalized into a product to send
out for review.)
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Author incorporates edits and comments into report and sends report
electronically for review).

Author(s) prepares CEC Form 5 to accompany report on sign-off route.

Author(s) sends report to office manager for review and sign-off.

Office manager sends report to division chief for review and sign-off.

Division chief sends report to Media and Public Communications Office
(MPCO) for review, editing, and sign-off.

After review, media office returns report to author(s) for edits to be
incorporated.

Author(s) incorporates edits into report.

Author(s) send report back to Media and Public Communications Office for
last review.

Report sent to Office of Governmental Affairs (OGA) for review. (Note: only if
legislatively mandated document. If not, M&PCO sends to Lead Commissioner.)

M&PCO or OGA sends report to Lead Commissioner for review and sign-off.

M&PCO, OGA, or Commissioner sends report to Executive Office for review
and sign-off.

Executive Office returns edited report to author(s).

Author(s) incorporates any additional final edits into report. Office manager
reviews report a final time to make sure final edits are added.

a. Author creates Adobe Acrobat Portable Document Format (PDF) file.

b. Author checks ADA accessibility of report and corrects areas not
accessible (tags).

c. Author fills-in document properties of report in PDF file. (See page 75.)

Author(s) sends Word, PDF, graphics, and other files to the Web Team for
posting on Energy Commission website and for archiving.

22

Web Team:

a. Assigns publication number to document.

b. Checks Americans with Disabilities Act accessibility of document.

c. Checks document properties.

d. Adds report information to publications database.

e. Codes final report HTML page for website, creates links from various pages

to report.
Puts report and graphic image of cover online.

)
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23 Webmaster sends PDF of final publication to Commission Library and
Publications Unit. These are usually sent each month on a CD-ROM.

24 Publications Unit prints master paper copy and prints limited number of
inventory copies.

25 Publications Unit sends printed copies to state depository libraries.

26 Webmaster archives electronic version(s) of publication to be kept indefinitely.

Source: California Energy Commission, Media and Public Communications Office

Report Sequencing

Occasionally reports go through several steps or versions. They can move through the
following steps, or they can start at Step 3 and go to Step 8:

Draft Consultant Report CEC-100-2015-001-DCR

Final Consultant Report CEC-100-2015-001-FCR

Staff Draft Report CEC-100-2015-001-SD

Staff Final Report CEC-100-2015-001-SF

Committee Draft Report CEC-100-2015-001-CTD

Committee Final Report CEC-100-2015-001-CTF

Commission Draft Report CEC-100-2015-001-CMD

Commission Final or Adopted Report  CEC-100-2015-001-CMF
Revised Commission Final Report CEC-100-2015-001-CMF-REV

OCRNU W=

Each of these report types is considered a separate report for review and sign-off.

A report is not called “draft” when it is sent around for review. It is called a “draft” only
if it is going to be published as a draft and a final report will be subsequently published.
Furthermore, please do not use a “DRAFT” watermark on Commission documents.

Moreover, reports may also be revised and republished. In this instance, the Media and
Public Communications Office will use the same publication number with a “-REV” suffix
added. The publication date on the cover should say “Revised: Month Date, Year.” For
example, if a final Commission-adopted report were to be revised, the number stack on
the cover would say:

CEC-100-2015-001-CMF-REV
Revised: October 27, 2015

The publication number assigned to the reports in the above sequence remains the same
throughout the entire sequence. The suffix added to the end of the publication number
is changed at each step. The suffix is added when the report reaches Media and Public
Communications Office (M&PCO) for its review and sign-off. Examples are given above.

If the report is part of such a sequence, please attach a note to the Form CEC-5 to
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inform MPCO of that fact so that a new publication number is not assigned in error.

Errata and Additional Revisions to Reports

Occasionally, a report needs small corrections because of typographical errors, or
revisions are made after the report is published.

If the errors are relatively minor, an errata sheet can be issued. The changes are
physically made in the Word file of the document, a new PDF is created, and the
publication number receives the suffix -ER [1]. (Use numbers if more than one errata.)
The MPCO also adds a PDF of the errata sheet to the original document so that original
document contains the errata sheet as part of the PDF.

If the report has major revisions, then the suffix -REV is added. Use -REV2, -REV3, and
so forth if more than one revision.

For more about publication numbering, please see the PDF file on EnergyNet at
http://energynet/Exec/doc_production/Publication_Numbering.pdf

Reproduction

The Energy Commission has additional procedures, beyond the review and publication
process, for mass reproduction of documents. A total of 500 impressions or fewer (10
copies of 50 pages, for example) may be duplicated using an office or division
photocopier. For amounts greater than 500 impressions, a reproduction order (Energy
Commission Form CEC-219) must be made with the Reprographic Unit in Business
Services. Find more on EnergyNet at

http://energynet.energy.state.ca.us/Admin/hrssb/Business%20Service/CopyCenter.html.
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CHAPTER 4:

Parts, Contents and General Formatting of
Commission, Committee, and Staff
Reports

Report Sections

As explained in Chapter 2, Energy Commission reports contain the following sections, in
the following order:

Cover page (required)

Credits page (required) with legal disclaimer (mandatory on committee and
staff reports) on the reverse side of cover

Acknowledgements page (acknowledgements are optional)

Preface (optional)

Abstract, keywords, and citation page (required)

Table of contents (required, followed by list of figures and list of tables, if
needed)

Executive summary (optional but required on policy documents)
Body of the report
References (if applicable)

Glossary/acronyms (If more than 10 acronyms or abbreviations are used, it is
required. Term definitions are also required.)

Bibliography (if applicable)
Appendices (if applicable) (Create a separate volume if very large.)
Attachments (if applicable)

This chapter will describe each of those parts, showing examples and explaining the
processes involved in creation of those sections.

The three main Commission-authored reports - staff reports, Lead Commissioner
reports, and Commission reports - have the same cover, but they have different credits
pages. Staff papers do not have a credits page. (See Chapter 8.)

Consultant and Energy Research and Development Division (ERDD) research reports are
covered in different style manuals. (See information in the preface to this report.)
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Cover and Credits Pages for Staff, Lead Commissioner,
and Commission Reports

Covers and credit pages for Energy Commission reports use templates that are available
from the Energy Commission “EnergyNet” Intranet website at:

http://energynet/Exec/doc_production

The templates have been updated and should work properly. Problems with past
versions of the templates have been resolved.

Cover of Commission, Lead Commissioner, and Staff Reports

Do not put a page number on the cover.
The required elements used on cover pages are shown in Figure 4 and are:

Title of the report.

Subtitle of report. (If not used, remove subtitle and line above subtitle.)
Type of report (Staff, Lead Commissioner, Commission Draft/Final Report)
Month and year published.

Publication number.

Commission seal, name, and Governor’s name and title.

Titles should be descriptive of the report. Titles are in title case in Lucida Bright, 29 pt.,
bold. Subheadings are in Arial Narrow, 18 pt. bold below a horizontal line.

Do not use abbreviations or acronyms in the titles of reports. Spell them out. For
example, if the report is about Assembly Bill 32, do not use “AB 32” in the report title.

Credits Page of Commission and Commission-Adopted Reports

The credits page of Commission reports is different from those of Lead Commissioner
and staff reports in that there is no disclaimer on Commission reports. Commission
reports also use the full Commissioners “stack.” (See Figure 6 below.)

The credits page is on the reverse side of the cover of the report. There is no blank page
in between covers and credits pages. The credits are on the left-hand side of the page.

The credits page of Commission and Commission-adopted reports requires the
following elements all in Lucida Bright typeface:

e Commission name in ALL CAPS, 16 pt. Arial, bold

e Commissioners stack (see Figure 6, next page) which includes:
o Chairman name
o Chairman title below name in bold, italic, followed by additional return
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O O O O

o

Vice Chair name

Vice Chair title below name in bold, italic; followed by additional return
The word Commissioners in bold, italic

Listing of the other three Commissioners by seniority rank

Additional two line returns

Executive Director name with title Executive Director below name in bold, italics

Name of primary author(s) with words “Primary Author(s)” below name in italics
(Note: If there are many authors, do not stack the names. Instead, put names
with commas between, but only use one-half of the page width.)

Name of project manager (if applicable) with words Project Manager below in

italics

Name of office manager, with the title “Manager” in italic below, followed by
name of office in italics below

Name of division chief, followed by title “Deputy Director” in bold italic below,
followed by division name in bold, italic below
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Figure 4: Staff, Committee, Commission, and Commission-Adopted Report Cover

California Energy Commission

COMMISSION REPORT

Title of Report, in Title
Case with Capitalized
Words Except for Some
Small Words Like a, the,
and, for

Subtitle of Report, If Used

Source: California Energy Commission, Media and Public Communications Office

The credits page should be one column long. If more space is required, please contact
the Media and Public Communications Office for direction.

Reminder: Always double-check the spelling of all names and titles!
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Cover of Commission, Committee and Staff Reports
Do not put a page number on the cover.

Figure 5: Commission and Commission-Adopted Report Credits Page

California Energy Commission

Robert B. Weisenmiller, PhD.
Chair

o o
Karen Douglas, JD.
Andrew McAllister
David Hothschild
Janea A Scott

Author(z) ames go here
One name per line
Primary Author(s)

Name goes here
Project Manager
Name goes here

Office Manager
OFFICE NAME GOES HERE

Namme goes here
Deputy Director
DIVISION NAME GOES HERE

Robert P. Oglesby
Executive Director

DISCLADMER

MY mander: of Do (Allforma lsaryy (comdiics prepaed Gl repert A Fecl B d0es 307 secesamrtly
regreses: @a views of the Bnargy Commusion, So employess, or @ Swoe of Calformie The Taargy
Cenmgaios. e T of (AROTRMA 1D NGO MA1 CORTASIENI RS FEDICLTNCIETS PMbe GBI WATTASL STEEeE
o1 Splied 438 wriaw 30 lagal HabGiry fo7 the (SSTTTMTOR 16 Wi FUPOTT 347 GOMI ASY PAITY TEZTEIEGT DAt
the wres of th iaformedss will Lot BTG Spea priveialy cwned fgbo TRU sepor ha 6ot Yees pmoved
- By @ fnargy O 207 Lad 1he ( SUMNEISICE Dazted SPOG Te SLIEFECY IF sSequesy of
e BIIrIDOL B B3 Tepert

Source: California Energy Commission, Media and Public Communications Office

A similar Commissioner stack is required on all brochures, posters, and other printed
materials the Energy Commission produces (either in-house or printed externally) or
that are done under contract for the Commission. Those documents also require the
Governor’s name and the Energy Commission seal. Please see Chapter 10 for additional
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information.

Lead Commissioner Credits Pages

Lead Commissioner reports use the same cover page as Commission report. Lead
Commissioner Report cover pages also are used for the Presiding Member Proposed
Decision (PMPD) for power plant licensing cases, usually with an artist rendition of the
proposed power plant on the cover.

Figure 5: Committee Report Credits Page

California Energy Commission

LEAD COMMISSIONER REPORT

Title of Report, in Title
Case with Capitalized
Words Except for Some
Small Words Like a, the,
and, for

Subtitle of Report, If Used

California Energy Commission

Edmund G. Brown Jr., Governor

ENERGY COMMISSION

p ——

Month Year | CEC-XXX-XXXX-XXX

Source: California Energy Commission, Media and Public Communications Office
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The credits page of Lead Commissioner reports requires the following elements:

e Commission name in title case, Lucida Bright 20 pt., bold

e Committee name in title case, 12 pt. Arial followed by:
o Presiding member name, with title and “Presiding Member” in bold italics
o Associate member name, with title and “Associate Member” in bold italics

e The following are in 11 pt. Arial, normal:
o Name of primary author(s) (if applicable)
o Name of project manager (if applicable), followed by title “Project
Manager” in italics
o Name of Energy Commission office manager, followed by the title
“Manager” in italics, followed by name of office
o Name of division chief, followed by the title “Deputy Director” followed
by division name in italics
o Name of the Executive Director with title below, in bold, italics
e Disclaimer - Mandatory if the full Energy Commission will be adopting the
report. The following boxed disclaimer must be added to the credits page if to be
adopted:

DISCLAIMER

This report was prepared by the California Energy Commission (Insert name of committee)
as part of (proceeding name) - docket # (XX-XX-XX). The report will be considered for
adoption by the full Energy Commission at its business meeting on month, date, year. The
views and recommendations contained in this document are not official policy of the Energy
Commission until the report is adopted.

The disclaimer title is in Lucida Bright bold 10 pt., ALL CAPS, centered, and the
disclaimer text is in Lucida Bright normal 7 pt., justified. The border around the
paragraph is % point in size, and the spacing around the paragraph is 8 pt.

The credits page is on the reverse side of the cover of the report. There is no blank page
in between covers and credits pages. The credits are on the left-hand side of the page
instead of along the right margin. The credit should be one column long. If more space
is required, please contact Media and Public Communications Office for direction.

Staff Report Cover and Credits Pages

The cover for Energy Commission staff reports is the same as the Commission and
committee reports but with the word “Staff Report” in the place where the type of
report is placed. Covers and credit pages for Energy Commission staff reports use
templates that are available from the Energy Commission “EnergyNet” Intranet website
at:

http://energynet/Exec/doc_production

The following disclaimer must appear in a box on the credits page of all staff reports.
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DISCLAIMER

This report was prepared by a staff member (staff members) of the California Energy
Commission. As such, it does not necessarily represent the views of the Energy
Commission, its employees, or the State of California. The Energy Commission, the State of
California, its employees, contractors, and subcontractors make no warrant, express or
implied, and assume no legal liability for the information in this report; nor does any party
represent that the uses of this information will not infringe upon privately owned rights.
This report has not been approved or disapproved by the California Energy Commission nor
has the Commission passed upon the accuracy or adequacy of the information in this
report.

The disclaimer title is in 12 pt. Arial, bold, and the disclaimer text is in 9 pt. Arial,
justified. The border around the paragraph is % point in size, and the spacing around
the paragraph is 8 pt.

The credits page is on the reverse side of the cover of the report. There is no blank page
between covers and credits pages. The credits are on the left-hand side of the page
instead of along the right margin. The credits should be one column long. If more space
is required, please contact Media and Public Communications Office for direction.

Other Types of Commission Reports

Other reports that the Commission publishes include draft and final versions (if
applicable) of the following:

Guidebooks (staff, committee, commission, draft, and final where applicable)
Instructions (staff, committee, commission, draft, and final where applicable)
Manuals (staff, committee, commission, draft, and final where applicable)

Preliminary and Final Staff Analysis or Assessments (of power plant licensing
cases)

Presiding Member Proposed Decisions (of power plant licensing cases)
Regulations (including 15-day, 45-day, 60-day language, and final)

These reports (and other types not mentioned here) use the standard Commission
report cover template. Change the “type” of report on the front cover to the applicable
type. Use the appropriate credits page with disclaimer (if non-Commission-adopted).

Regulations, decisions, manual, and guidebooks are publications that do not get the
high-level of editing and review as regular Energy Commission reports. They still must
go through review and sign-off using a CEC Form 5. Commission editors, however,
know that the language of these publications is very exact and must be left (in many
cases) as it is written. That does not mean that writers should be careless in
punctuation, grammar, and spelling. These documents should follow the formatting and
content standards set forth in this Commission style manual.

The only exception to the sign-off process and the need for a CEC Form 5 are power

plant siting case reports. These are the preliminary and final staff assessments (PSAs

and FSAs, respectively), the presiding member proposed decisions (PMPDs), and Energy

Commission final decisions. Siting Division office managers, the siting division chief,
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General Counsel Office, and the Hearing Office (where applicable) review and edit these
reports. Usually they are not edited or reviewed by the Media and Public
Communications Office or the Executive Office.

For consultant reports, see Publication Number CEC-180-2015-XXX.

For Energy Research and Development Division project reports, see Publication Number
CEC-180-2015-XXX.

Publication Numbers

All Energy Commission external publications (reports, papers, presentations and
speeches, brochures, flyers, handouts, fact sheets, CD-ROMs, DVDs, and so forth) are
assigned a publication number. Presentations given at workshops and hearings are not
assigned a publication number unless a specific request is made.

The format for publication numbers is
CEC - XXX - YEAR - XXX - suffix - format id
The parts of the publication number are:

The Commission identification with the ANS.

The division, office, or program area number for which the report was originally
written.

The year the report is published.

The sequential number of the report for that division.

A suffix (if needed).

A format identification (such as -BR for brochure, -FS for fact sheet, -CD, -DVD).

A hyphen is used between each part.

Staff in the Media and Public Communications Office (MPCO) will assign the publication
number when the document reaches them for editing and review. In the case of a PSA,
FSA, or PMPD, the author will request a publication number directly from the Web Team.
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Suffixes at End of Publication Numbers

Suffixes are added by the Media and Public Communications Office to the end of the
publication number only if necessary to differentiate various versions, volumes,
editions, or parts of the same document. The suffix is preceded by a hyphen.

More information about publication numbers can be found on the PDF file on the
“EnergyNet” Intranet website at:

http://energynet/Exec/doc_production/Publication_Numbering.pdf

Other Report Sections

Acknowledgements Page (Optional)

This page comes after the credits page and precedes the preface, abstract, and table of
contents. Page numbering begins on this page with lowercase Roman numerals (i, ii, iii,
iv, v, vi, and so forth).

What Are Acknowledgements?

Acknowledgements express appreciation by the authors or committee members to those
who participated in the gathering of information for or the writing of the report. It may
be a paragraph or a bulleted list of names and, if appropriate, their affiliations.
Acknowledgements are optional.

If there is a long list of participants who are to be acknowledged, put the names and
affiliations in two or three columns.

Preface Page (Optional)

This page comes after the credits page and acknowledgements (if used) and precedes
the abstract page and table of contents. Page numbering begins on this page with
lowercase Roman numerals (i, ii, iii,) if it did not begin on the acknowledgements page.

The preface is an introduction to the report generally explaining the subject, scope, or
aim. If the report is legally or legislatively required, the preface states the law or
mandate that dictates that the report be done.

Abstract, Keywords, and Citation Page (Mandatory)

The abstract, keywords, and citation have been gathered together on one page. This
page should be referred to as the “abstract page.” Below is an example.
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Figure 7: Example of Abstract/Keyword/Citation Page

ABSTRACT
(REQUIRED FOR ALL COMMISSION REPORTS/PAPERS)

Abstract text goes here,

Keywords: (Required for all Commission Reports/Papers)

Citation is required for all reports/papers.

If there is no Acknowledgements page, the citation goes at the bottom of the Preface
page; if there is no Preface, the citation goes on the reverse side of the credits page.

Please use the following citation for this report

Author(s) Last Name, First Name, subsequent author(s) are First Name, Last Name. Year
of Publication. Title of Report. California Energy Commission. Publication Number:
CEC-XXX-201X-XXX

Source: California Energy Commission, Media and Public Communications Office

Abstract

All Energy Commission reports are required to have a short abstract. This concise,
informative summary of the report should be less than 300 words - about a half page,
single-spaced. (You can use “Word Count” in the “Tools” menu of Microsoft Word to
check the number of words.)

The abstract should address the report purpose, scope, methods, and major findings,
including the report results, conclusions, and recommendations.
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Abstracting services publish abstracts to help readers determine whether a report is
targeted to their area of interest; therefore, it should be understandable as a stand-alone
document. The abstract should not contain undefined symbols, abbreviations, or
acronyms and should not refer to specific elements of the main report. It should not
refer to other reports unless it is essential to clarify the document purpose. If the report
is a supporting document to another report, that information should be noted. Do not,
however, include citations within the abstract.

Place the abstract on an odd-numbered, right-hand-facing page.

Keywords

The abstract page must contain five or more keywords that will help search engines and
other databases find the report subject matter. Do not repeat words. The keywords
should be listed separately and spaced about five lines below the end of the abstract.
Separate each word by comma - followed by a space - with no ending punctuation. For
example:

Keywords: California, solar, energy, photovoltaic, PV, cell, panel, building, integrated,
BIPV, electricity production, distributed generation, initiative, CSI, emerging, renewables,
program, rebate

Citation Information

The citation used to be at the bottom of the acknowledgements or preface page. As
those pages are optional, the citation has been moved to the abstract page.

It is mandatory to include a citation for your report in the following style:

e Author last name, author first name (or initial). Note: If there are multiple
authors, list with chief author name first, or list alphabetically. The first name in
the series should have the last name followed by first name; all subsequent
authors have the first name, then the last name. Use commas between authors’
names.

Year of publication.

Report title in italics.

California Energy Commission (as publisher).

Energy Commission publication number.

Citation Example:

Wolman, H., R. E. Moon (Engineering International). 2007. Widgets and More. California
Energy Commission. CEC-500-2006-987. (That is, Woolman and Moon work for
Engineering International, so this optional method of listing authors
incorporates the authors and the company for which they work.)
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Additional Examples:

Aldrich, Bob, Susanne Garfield-Jones, Lana McAllister, Carol Robinson, Carolyn Walker,
Michael Wilson. 2010. Style Manual (Second Edition) for California Energy
Commission Staff, Committee, and Commission Reports, Presentations, and
Papers. California Energy Commission, Media and Public Communications Office.
CEC-180-2010-001.

Burt, Charles, Darren Cordova (Irrigation Training and Research Center, California
Polytechnic State University). 2002. Electric Load Shifting in Irrigation Districts -
California Program. California Energy Commission. CEC-400-2002-002.

Unnasch, Stefan, Michael Chan (TIAX, LLC). 2007. Full Fuel Cycle Assessment: Tank to
Wheels Emissions and Energy Consumption. California Energy Commission. CEC-
600-2007-003.

Table of Contents

Include the following sections in the table of contents:

Acknowledgement (optional)

Preface (optional)

Abstract, Keywords, and Citation (required)

Executive Summary (required in all consultant reports and policy reports)
Chapter number and title followed by subheadings using the following format:

Chapter 1: Chapter Title in Title Case (Heading 1)
o Subheading (Heading 2)
»= Sub-subheading (Heading 3)
- Sub-sub-subheading (Heading 4)

e Appendices (if applicable) (Enter appendix letters and titles in the table of
contents manually)

e Attachments (if applicable) (Enter attachment numbers and titles in the table of
contents manually)

Generate the table of contents using Microsoft Word automated feature. To do so, go to
Insert > Reference > Index and Tables > Table of Contents > OK. Add at least two levels
of heads (no more than three) under the table of contents to help the reader know the
contents of the chapters.

Following the table of contents, generate the list of figures and the list of tables, if
needed, using Word automated features. To do so, go to Insert > Reference > Index and
Tables > Table of Figures. Under “Caption Label” choose either Figure or Table, then in
Options, Style, choose "Figure caption" (for a figure) or “Table caption” (for a table) >
OK.

Update the table of contents, list of figures, and list of tables after all editing has been
completed, and proofread to ensure that the entries are complete and correct.
(Microsoft Word automatic table of contents feature, while very useful, is not perfect
and can occasionally miscreate entries.) Appendix and attachment listings must be
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entered by hand. Do not provide page numbers for appendices or attachments.

The table of contents should use a right-hand tab, set at 6.5-inches, and with a dot
leader for the page numbers. Set other tabs (for subheading and sub-subheadings) at
0.25- and 0.50-inch. Break long titles using a soft-return (shift-enter) and a hanging
indent.
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Figure 8: Example of Table of Contents

(If you correctly use the Heading Styles, Section Title Style, Figure Titles Style and Table
Titles Style when composing the document, these lists will be automatically generated and
will reflect any changes in titles and page numbers.)

TABLE OF CONTENTS

Page
Acknowledgements (Optional)... e ORRP |
PHRIACE (ODUIOMRD oisnsiisimiiinmnis i i v RGN R BRI il

Abstract (Required for all Commission Reports/Papers)u e

Table of Contents

LisEOT FRDIINS s niicivnminmim o smmyi i rmne emirr maaa v

LERRTOR I vivsivnncosrineais s mbiumsssshsreddnmses s VSHH I A OGNS AOR TABRFoTERARAO Ned iv

BRECUIVE SUINMAYY. casimisneisivissnsasessestamsisssmisissasicsssisniniimossosnscnniansnmssmonD

(Required for all consultant and policy reports/pPapers.) wuessmsssssssssssssessssssess 0
o OSSN SO NICHIYGE s coontosnsoussswancvacomammnssamnen o AR ey AT ANV 6
CHAPTER1:'WhY I8 This PaDer: INDOXTAIIE isuisancasansvsississocsusnisinssosnsnsssoinsouibisansssssdssissinssosssinsiibncsics
Heading 2: Please Read This Paper......
Heading 3: This Is a Good Paper

APPENDIX A: Name of AppendiX......omenmmmmminin 10
AAITDURIRIE S TG URALIIR . wsvvesvryos o oo oeommo s YW TS VOIS T AT PRV NSNS MV D Y S 10

LIST OF FIGURES

Page
Figure 13 Text Goes Here in TIUE CASE ... 8

LIST OF TABLES

Table 1: Text Goes Here in Title Case

Source: California Energy Commission, Media and Public Communications Office
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Executive Summary

The executive summary is a final report in miniature, containing all the key information.
It summarizes the report and should include the following headings:

Introduction or Background

Purpose (outlining the broad purpose)
Objectives (if appropriate)
Conclusions and/or Recommendations

These subheadings should appear in the table of contents.

The executive summary is intended to be short (preferred length is 2-10 pages). It can
use a succinct, bulleted format to summarize the pertinent points under each of these
sections, or can be more conversational (but still succinct). Assume a nontechnical,
management-level readership.

The introduction summarizes the purpose of the report and explains the reason the
Energy Commission wrote the report. An introduction should give the relevant
background and overview. It should define (at an intelligent layperson level) the issue or
problem being addressed by the report.

As a report summary, the executive summary should not present new information that
is not found in the main document, and the executive summary should not just repeat
the abstract.

Do not cite references in the executive summary, and with rare exceptions, do not use
acronyms or abbreviations. If you must use acronyms or abbreviations, use the spelled-
out term first.

The Executive Summary uses the same “ALL CAPS” style that is used on preface and
abstract titles.

The executive summary marks the division between front matter, using lowercase
Roman numeral pagination, and the body of the report. Thus, the first page of the
executive summary will always be page 1 (Arabic numbering) of the report.

Chapters and Section Headings

Chapters should be numbered (CHAPTER 1:, CHAPTER 2:, and so forth in upper case)
followed by a colon, a shift-return (soft return), and then the chapter title in title case.

Use a soft return again [shift-return] if you need to break the title into two lines. Avoid
orphaned words. Instead, use a soft-return to group words in lines of two or more.

You do not need to capitalize the following words, unless they begin the title or a
second line:

41



a an and Dby for or the
Example:
CHAPTER 1: How You Should Create Excellent Titles for Commission Reports

The example above is awkward because it orphans the word “Reports.” Break the line
(with shift>return) to group common words together:

Good:
CHAPTER 1:
How You Should Create Excellent Titles
For Commission Reports
Better:
CHAPTER 1:
How You Should Create
Excellent Titles for Commission Reports
Best:

CHAPTER 1:
Creating Excellent Titles for Commission Reports

The example marked “Better” uses a stepped format that is more pleasing to the eye,
but the example marked “Best” is cleaner-looking and reads better.

DO NOT USE scientific or technical section numbering (Section 1.1, Section 2.1.6) for
subheadings within chapters. Only Energy Research and Development Division reports
may use scientific or technical section numbering.

References

The references section at the end of the report must list all documents cited in the body
of the report. List references in a standard alphabetical format. Use Lucida Bright font,
10 pt. Please check that all of the references contained in the body of the report are
accurate and that the full citation for each reference is listed in the references section.

The reference formatting chart below is based upon The Chicago Manual of Style (16th
Edition) and uses categories from the citation chart of The Purdue OWL.4

For references within the body of the report, please see page 53.

4 For the chart, please consult https://owl.english.purdue.edu/media/pdf/20110928111055_949.pdf.
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Glossary

If the report uses more than 10 acronyms and abbreviations, please provide a glossary
with definitions for each acronym. Use Microsoft Word table feature to create a two-
column format with the acronym or abbreviation and the spelled-out term in the left
column and the definition in the right column.

Bibliography

A bibliography includes references that were used in preparation of the report not cited
in the report. This section is optional. If used, consult citation chart mentioned in the
references section, above, for formatting guidance.
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CHAPTER 5:
Appendices and Attachments

An appendix is usually supplementary material that is produced by the report author.
An attachment is usually supplementary material that is produced by someone other
than the author.

Important Note About Copyrights and Permissions

If an attachment or an appendix has been previously published, the author must obtain
written permission from the copyright holder before the Energy Commission can
republish or put that document online.

You should ask for “written permission for electronic publishing of the document in
Adobe Acrobat PDF format on the California Energy Commission website.” Make sure
there is no time limit on the permission - that is, ensure that the file may be posted on
the Energy Commission website indefinitely.

Send a photocopy of the written permission to the Webmaster when you deliver the
report and the appendix(ces) or attachment(s).

Most previously published documents will be posted as separate files, with cover pages.
No credits page is needed for appendices or attachments not funded by the Energy
Commission. On the cover page where the words “Prepared By” are located, please
include the following statement:

Please Note: This document is an attachment to a report prepared/funded by the
California Energy Commission. The Energy Commission did not prepare or fund this
attachment, but the author(s) has/have requested it be available as a supporting
document.

The Energy Commission wishes to thank the copyright holder, [fill in name of author
and/or publisher or whomever holds the copyright], for permission to republish this
document in electronic format on the Commission website.

Please contact the original author/publisher for additional information about the
document at [fill in company website address, phone number, or e-mail address].

Appendices

An appendix is supplementary material that is usually produced by the report author(s).
Designate appendices by capital letters (Appendix A, Appendix B, Appendix C, and so
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forth), not numbers.

The body of the report needs to refer clearly to the attached appendix. References in the
main report to information contained in the appendix should indicate the specific page
or section of the appendix, not just a general reference to “Appendix D.” The report
should also explain how the material in the appendices matters to the text. If it does not
really matter, the appendix probably should be dropped.

Formatting and Editing of Appendices

Appendices should use the same Energy Commission-required formatting and style as
the main report. If an appendix was previously published using a different style and
format, that organization or other agency style and format does not necessarily need to
be changed. Please contact Media and Public Communications Office for directions on
appendices that were previously written.

The content and format of an appendix is subject to editing just like the report itself.

If small enough, appendices will usually be a part of the actual report. There are two
formats for the appendix cover page. An appendix cover page should appear similar to
what appears in Figure 9 on the next page. The version on the left is the preferred
because it saves paper; as you would need an additional blank page so that the content
starts on the right-hand side.

Each separate appendix must have a cover page and publication number. If the Energy
Commission funded the work, each appendix must also have a credits page. The Energy
Commission provides the publication number when the report reaches the Media and
Public Communications Office for review and sign-offs.

If the appendix has been previously published by another organization or agency with a
different cover, it receives an Energy Commission cover page but no credits page. If the
work contained in the appendix was not funded by the Energy Commission, be sure the
cover page contains the boilerplate copyright permission language provided earlier in
the “Copyrights and Permissions” section.

Appendices Publication Numbers

The publication number of an appendix consists of the main report publication number
plus a suffix. If there is only one appendix, the suffix is -AP. If there are multiple
appendices, the suffixes are -APA, -APB, -APC, and so forth, depending on the letter of
the appendix. Therefore, the publication number for Appendix B of a fictitious report
published in 2007 by the Energy Efficiency Division would be: CEC-400-2015-987-APB.

If multiple appendices are combined in one volume, then the suffix is only -AP with no
additional letter.
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Page Numbering of Appendices

Page numbering of appendices should include the letter of the appendix followed a
hyphen and then by the page number. The same convention of page numbering used in
regular reports is also used in appendices.

Example of page numbering: A-1, A-2, A-3; B-1, B-2, B-3; and so forth.

Appendices as Part of the Main Report

If the appendices are short enough, they may be included in the same Word file as the
main report. The first page of each appendix should be a title page, containing the
following information:

e The word “Appendix” (with letter A, B, or C, and so on if more than one
appendix), in Lucida Bright 20 pt., bold, upper case.

e Title of appendix, in Lucida Bright 20 pt., bold, title case. Use a soft return for
the following line.

e A-1,A-2, A-3, and so on (or B-1, C-1, and so on), page numbering centered on the
bottom of the page. Use Arabic numerals.

Figure 9 shows the format of what appendix title page could look like.
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Figure 9: Example of Appendix as Part of Main Report

APPENDIX A:
Name of Appendix

Start Document Here

Appendix Subheading
Please type here

Appendix Sub-subheading
Please type here,

Appendix Sub-sub-subheading
You may type here.
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Appendices as Documents Separate From the Main Report

If the Word file created by an appendix is too large (more than 5.0 megabytes), treat it as
a separate volume from the main report.

Where the appendix would normally go in the main report, insert a “slip sheet” that lists
the following information:

e Appendix A (or B or C, and so forth), in Lucida Bright, 20 pt., bold, then two
returns.

e Title of appendix, in Title Case, Lucida Bright, 20 pt., bold.

e Text on the slip sheet saying: “This appendix is available as a separate volume,
Publication Number CEC-XXX-YEAR-XXX-APX.”

e The slip-sheet has no visible page number.

Please see Figure 10 for an example of a “slip sheet” for a single appendix that is a
separate volume.

If there is more than one appendix, the titles of each appendix should be listed on a
single “slip sheet.” The title of the page, in that case, should be “Appendices” (Arial 24
pt., bold) with the appendix letters and titles, and associated publication number(s),
neatly arranged as a list. Please see Figure 11 for an example of multiple appendices
listed on a “slip sheet.”

If you have multiple small appendices, they may be combined into a single volume if the
file size permits. If the multiple appendices create a file larger than five megabytes, then
separate volumes should be created for each appendix. Appendices are posted online in
Adobe Acrobat PDF format.
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Figure 10: Example of a “Slip Sheet” for Appendix A

APPENDICES

Appendix A: Alternative and Renewable Fuels
Appendix B: The Smart Grid

Appendix C: Energy Efficiency for Existing Buildings
Appendix D: Energy Generation and Usage Forecasts

Appendix E: Renewables Portfolio Standard

Source: California Energy Commission, Media and Public Communications Office

Appearance in Table of Contents

When preparing the table of contents for the report, you may need to manually enter
each appendix letter and title (or attachment number and title) into the table of
contents. Contents of the appendix, however, are generally not included within the table
of contents.
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Attachments

Attachments are supporting documents that usually were not written by the author of
the main report. An attachment may also be supplementary material that may not
directly relate to the report. For example, attachments can include a collection of news
articles that appeared on a certain topic.

Attachments are designated with Roman numerals rather than letters (Attachment I,
Attachment II, and so forth).

Most previously published documents will be posted as separate files, with the
respective cover pages. No credits page is needed for appendices or attachments not
funded by the Energy Commission. On the cover page where the words “Prepared By”
are located, please include the following statement:

Please Note: This document is an attachment to a report prepared/funded by the
California Energy Commission. The Energy Commission did not prepare or fund this
attachment, but the author(s) has/have requested it be available as a supporting
document.

The Energy Commission wishes to thank the copyright holder, [fill in name of author
and/or publisher or whomever holds the copyright], for permission to republish this
document in electronic format on the Commission website.

Please contact the original author/publisher for additional information about the
document at [fill in company website address, phone number, or e-mail address].

Attachments are usually published separately from the main report. Prepare a single
“slip sheet” and cover page(s) the same way as for appendices. Also include the
attachment information in the report table of contents.

The Media and Public Communications Office will assign a publication number to each
attachment. The publication number of an attachment consists of the main report
publication number plus a suffix. If there is only one attachment, the suffix is -AT. If
there are multiple appendices, the suffixes are -ATI, -ATII, and so on, depending on the
letter of the attachment. Therefore, the publication number for Attachment II of the
same fictitious report published in 2015 by the Energy Efficiency Division would be:
CEC-400-2015-987-ATIL.

In almost all cases, attachments will require permission to publish from the copyright
holder. It is the report author’s responsibility to obtain this permission. You should ask
the author or publisher for “written permission for electronic publishing of the
document in Adobe Acrobat PDF format on the California Energy Commission website.”
Make sure there is no time limit on the permission - that is, ensure that the file may be
posted on the Energy Commission website indefinitely.
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The permission language appears on the cover of the attachment in a box similar to the
one below. Send a photocopy of the written permission you have obtained to the
Webmaster when you deliver the report and the appendices or attachments.
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CHAPTER 6:
Preparing Accurate, Consistent Reports,
and Report Content Styles

Before you begin writing, put on the hat of an inquisitive, reasonably educated lay
reader. Pretend that he or she paid for this report and wants to understand how and
why you spent the money. That is your intended audience. Even though colleagues in
the energy industry may be the only people who read your report, you need to make the
writing clear and understandable to a larger audience. Your reader may not speak or
read English as a first language. So, you must write clearly and concisely.

Here are some suggestions to keep in mind as you write the report:

Apply the test of completeness. Are all the pieces there? Are all the references
clear, and do those in the text match those in the reference section? Are the
relationships between the partners and the players clearly explained?

Apply the test of logic. Does the document flow and make sense? Is the need for
the research clearly described? Is the technical approach clearly described? Do
the conclusions make sense? Are they drawn from the analysis? Do the numbers
check? Is it clear how the numbers were derived?

Analyze data that you present in the report. If you present a picture, graph, or
table, be certain to discuss it in the text; do not just refer to it. Remember, not
everyone wants to or can print in color, so it is best if your graphic can also be
copied in black and white. Apply the “would this be clear if it were faxed” test.

Make sure you substantiate each conclusion by the analysis contained in the
report.

Figures and tables must clearly relate to and be consistent with the text, and vice
versa. (If the text says the generator had a capacity of 30 megawatts, the table
should not say it was 31.2 megawatts.)

Use consistent references to report performance specifications and results. For
example, if you refer to a piece of equipment by its nominal nameplate rating,
then use that reference consistently throughout the report. If, however, the
desired number was the measured performance of the device (almost always
different from nameplate), then consistently use that measured number. Do not
mix the two in the narrative.

The text must clearly refer to the attached appendices (if applicable). It should
also explain how the material in the appendices relates to the text. If the content
does not really matter, you should probably delete the appendix. References to
multi-page appendices need to be specific to the page or section of the appendix,
not just a general reference to “Appendix B.” Number appendices pages
consistently.

Apply general rules for good writing to all reports and other written materials
created or funded by the Energy Commission. The following books and website are
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recommended to assist authors in developing good writing habits:

e Sabin, William A. The Gregg Reference Manual (10th edition). McGraw-Hill Irwin,
2005. ISBN: 0072936533.

e Fiske, Robert Hartwell. To the Point: A Dictionary of Concise Writing. W.W. Norton
& Company, Inc., 2014. ISBN: 978090383347173

e Strunk Jr., William, E. B. White, The Elements of Style, The Original Edition.
www.bnpublishing.com, 2008. ISBN: 9562919897

e Style Manual Committee, Council of Science Editors. Scientific Style and Format:
The CSE Manual for Authors, Editors, and Publishers (7th Edition). University of
Cambridge, 2006. ISBN: 097796650X.

e University of Chicago Press Staff (Editor). The Chicago Manual of Style (16th
Edition). University of Chicago Press, 2003. ISBN: 0226104036.

e U.S. Energy Information Administration Office of Communications. EIA Writing
Style Guide. 2012. http://www.eia.gov/about/eiawritingstyleguide.pdf.

The above resources may disagree on grammar and punctuation formatting, such as
using a “serial” comma. The Energy Commission preference is the Gregg Reference
Manual. The Media and Public Communications Office recommends that each office
have at least one copy of that manual.

If you have a question about what the report should include, contact the Media and
Public Communications Office to discuss the report. Make sure you understand all
the required report elements.

Writing Style

e Use the active voice whenever possible:
ACTIVE VOICE: The petroleum industry builds new storage facilities.
PASSIVE VOICE: New storage facilities are built by the petroleum industry.

e The Energy Commission discourages the use of the first person (I, we, us, our)
when referring to the author(s) in its reports. This is not to say that you should
write in the passive voice. It is possible to write in the third person and still write
in the active voice. For example:

o Instead of third person passive voice: “It was found by the research team, or
it was found by the researcher that ...”

o Use third person active voice: “The research team or the researcher found
that ...” or “The study found that ...” or “Results showed that ...”

e Writing in the third person requires that the authors refer to themselves as
though they were referring to a third party:
o First person: “We considered 12 different scenarios ...”
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o Third person: “The authors [or “the research team” or “the researcher” or
“this project” or some other similar third-party reference] considered 12
different scenarios ..."

e [Eliminate excess words. For example, say “To calculate the emissions ...” NOT “In
order to calculate the emissions ...” The Dictionary of Concise Writing can help
writers use fewer words to convey their message. For example, say, “The team
analyzed ...” and not “The team conducted an analysis of ...” Other unnecessary
words include “process,” “activities,” “efforts,” and “for ... purposes.”

e Avoid using “etc.,” “e.g.,” or “i.e.” Instead, use “and so forth,” “for example,” or
“that is,” respectively, or another appropriate substitute.

Acronyms and Abbreviations

An acronym is an abbreviation made up of the initial letters of a group of words and is
pronounced as a single word. For example, HVAC (heating, ventilation, and air
conditioning) is pronounced H-VAC. Abbreviations are the initial letters of a group of
words but cannot be pronounced as a single word and in which each letter is spoken
individually, such as CPUC and PG&E. The Energy Commission uses these two terms
interchangeably, most often including abbreviations under the umbrella of acronyms.

Use acronyms sparingly! They are a form of shorthand for terms used repeatedly
that are familiar to your readers. Do not make up your own acronyms. This style of
writing excludes the reader by introducing words that are only known to a “select few.”

An acronym should benefit the reader, not cause them to stop reading and start hunting
for the meaning of the acronym. Acronyms may be disallowed at the discretion of the
Energy Commission editors.

Follow these rules when using acronyms or abbreviations.

e Do not make up acronyms as shorthand for a group of words.

e Do not use the abbreviation “CEC” in reports or in other written materials,
except if used in a table heading where space is limited. Use “California Energy
Commission” at first mention, and then use "Energy Commission" throughout
the rest of the report. You may use “Commission” in subsequent references in
the same paragraph as long as no other commissions are being mentioned.
Return to using the full two words Energy Commission in subsequent
paragraphs.

e Introduce acronyms by first using the full term, followed by the acronym in
parentheses. Energy Commission style does not allow the use of acronyms in the
abstract and executive summary because these sections may need to stand alone
and because these elements are often read by a broader audience that may be
less familiar with the subject matter. Very common acronyms or abbreviations
are acceptable in abstracts and executive summaries. (See Table 1.)

e Do not introduce and use an acronym if it only appears once or twice in close
proximity. Rare exceptions would be cases where readers are more familiar with
the acronym than the actual referent.

e Do not use the U.S. Postal Service two-letter abbreviations for states in the United
States. Instead, use the full state name (example: Sacramento, California).
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Table 3: Common and Acceptable Acronyms and Abbreviations

Original Term

Acronym/Abbreviation

Alternative and Renewable Fuel and Vehicle
Transportation Program

ARFVTP

California Energy Commission

Energy Commission

British thermal unit

Btu

California Air Resources Board

ARB (not CARB)

California Department of Water Resources

DWR

California Environmental Protection Agency

Cal/EPA (use a slash mark between Cal and EPA)

California Department of Forestry and Fire
Protection

CAL FIRE

California Independent System Operator

California ISO (not CAISO or Cal-ISO)

(California) Public Utilities Commission

CpPUC

California Department of Transportation

Caltrans

carbon dioxide

CO, or CO2 (Note: Make sure the 2 it is not too
small to read.)

community choice aggregation CCA
cubic feet per minute CFM
(United States) Department of Energy U.S. DOE
Electric Program Investment Charge EPIC

Energy Action Plan

Energy Action Plan (not EAP)

Energy Efficiency Ratio, Seasonal Energy
Efficiency Ratio

EER, SEER

ENERGY STAR"”

ENERGY STAR"® on first reference with registered

trademark in superscript, followed by ENERGY
STAR thereafter. Note: Can be all capitals.

Federal Energy Regulatory Commission FERC
fuel cell electric vehicles FCEV
gigawatt/gigawatt-hour GW/GWh
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Governor’s Office of Business and Economic GO-Biz
Development

greenhouse gas GHG
heating, ventilation, and air conditioning HVAC
Integrated Energy Policy Report IEPR
kilovolt kv

kilowatt/kilowatt-hours

kW (small k, capital W)/kWh

liquefied natural gas, liquefied petroleum gas

LNG, LPG

Los Angeles Department of Water and Power

LADWP

MCF

MCF but in parentheses say (1000 cubic feet of
natural gas)

megawatt/megawatt-hour

MW (all capitals)/MWh

nitrogen oxides NOx or NO_
Nuclear Regulatory Commission NRC
Organization of Petroleum Exporting Countries | OPEC
Pacific Gas and Electric Company PG&E
photovoltaic PV

Public Interest Energy Research PIER

one quadrillion (10") British thermal units Quad
research, development, and demonstration RD&D
Sacramento Municipal Utility District SMUD
San Diego Gas & Electric Company SDG&E
Note: An ampersand is the correct usage in the

company name.

Southern California Edison Company SCE
Southern California Gas Company SoCal Gas
sulfur oxides SOx

United States

United States (not U.S. unless it proceeds an
abbreviation for a federal agency)

United States Environmental Protection Agency

U.S. EPA (not EPA)
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Source: California Energy Commission, Media and Public Communications Office

Bulleted Lists

Consider using a bulleted list for complicated sentences like the following example:

This report provides policy recommendations to conserve resources; protect the
environment, the economy, and public health and safety; and ensure reliable, secure,
and diverse energy supplies.

The above is correct, but it is clearer if bullets are used.
This report provides policy recommendations to:

e (Conserve resources.
e Protect the environment, the economy, and public health and safety.
e Ensure reliable, secure, and diverse energy supplies.

Note: The Gregg Reference Manual (p. 9, paragraph 107a) states: “... use periods after
short phrases that are essential to the grammatical completeness of the statement
introducing the list.”

In the above example, you should not use semicolons at the end of the first and second
bullet. Nor would you put the conjunction “and” at the end of the second bullet. The
above bulleted items are incomplete sentences, but because they grammatically
complete the lead-in phrase, periods are used.

Rules for Bullets

If a bullet makes a complete sentence or completes the lead-in, put an end mark. If not,
no end punctuation should be used.

In bulleted lists, use “parallel construction” for the items in your list. For example, if one
item starts with a verb, all items should start with a verb; if one item begins with a
noun, all items should begin with a noun, and so forth.

Use the following guides for punctuating bulleted lists:

Start each bulleted element with a capital letter.
Place a period at the end of each listed element that is a complete sentence.

e Incomplete sentences should not have a period unless they are “essential to the
grammatical completeness of the list.” (See note above.)

e Semicolons or commas should not be used as end marks.
e The word “and” should not end the second to the last bulleted item.

Do not use small graphic files in place of the standard bullets.
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Format for Bulleted Lists
1) The hierarchy for bullets should be:

e Bullet item (round, solid disc)
o Second level bullet (open circle)
» Third level bullet (solid square)
- Fourth level bullet (hyphen)

2) Add an additional return (extra line) at the end of the bullets and before the next
paragraph.
3) Bullets use standard/normal text (Lucida Bright normal, 10 pt.) but should only

have a 4 pt. spacing following the paragraph. It is included in the blank document
template, but you may have to change this manually. To do that, highlight the bulleted
section and go to the pull-down menu:

Format>Paragraph>Indents and Line Spacing>Spacing After = 4 pt.

4) Always format bullets with a hanging indent, indenting 0.25-inch from the line
above with the hanging indent at 0.50-inch from the line above.

Capitalization

Do not capitalize words to make them stand out in a text. For example, “The
Department offered its services.” is incorrect and should be “The department offered its
services.” Capitalization should be reserved for proper nouns, which are names of
specific persons, places, things, or events.

Just because acronyms and abbreviations are most often capitalized does not mean that
you must capitalize the terms when they are written out. For example, you would not
capitalize heating, ventilation, and air-conditioning (HVAC) system prior to listing the
acronym in parentheses.

Do not capitalize words in the following situations:

e Do not capitalize “state” unless the text specifically says “the State of California”
or unless state is being used as a noun.

Examples:
The State is considering adoption of new regulations.
New state regulations are being considered.

e Use “energy crisis,” NOT “Energy Crisis.” A proper noun, however, like “2001
Energy Crisis” would be capitalized.

e Use the lower case for “project” or “program” or “model” unless the term is an
official part of a name or title, such as “Sunrise Transmission Project” or the
“EPIC Program” or the “Cost of Generation Model.” (In subsequent references to
the project or program or model, use the lower case for the term even though it
capitalized when you use the official name. For example, regarding the Sunrise
Transmission Project, subsequent mentions would be to “the project” if you

58



don’t want to use its full name.)

e Use “website” (all one word, lowercase) and not “Website” or “web site.” However,
use “Web page,” “Webmaster,” and “the Web.” Per the Gregg Reference Manual,
to maintain a consistent style, it is better to retain the capital “W” until a
majority of these terms (such as “World Wide Web”) lose their initial cap as well.
Website, however, has lost the initial cap in most technology publications,
newspapers, and websites.

e Do not capitalize “city” before the name of a municipality unless it is part of its
formal name. For example, “city of Sacramento,” not “City of Sacramento.” The
actual name of the city is Sacramento, California. For some cities, the word “city”
is part of its formal name, such as the City of Industry, California.

e Do not capitalize any term that is not a proper name or title.
e Do not capitalize “staff.”

Words that should be capitalized are:

e Governor, Legislature, Senate and Assembly (when pertaining to California), and
Executive Director.

e Northern California, Southern California, Central California, the State (when used
as a noun as a stand-in for State of California).

e (Cap-and-Trade Program, according to the California Air Resources Board.

The terms that are capitalized may disagree with some grammar conventions. These are
Energy Commission style for using these terms.

Adjective Phrases and Adverbs

Do not hyphenate adjective phrases: “publicly owned utilities,” or adverbs: “newly
created.”

Compound Adjectives

Many compound adjectives are hyphenated when they come before a noun: “investor-
owned utilities.” They are not hyphenated when they come after the verb: “the utilities
are investor owned.”

Internet and Email Addresses

You can configure Microsoft Word to automatically create hotlinks to Internet addresses
(URLs, short for Uniform Resource Locator) and a mail-to link for email address.
Creating the hotlink changes the text to blue and underlines the text (in Word default
settings). When a user clicks on the link, the text color changes to purple. Changing the
Word file to Adobe Acrobat sometimes incorporates the hotlinks. Please make sure the
addresses are correct and tested before submitting a report.

Note: Email in Energy Commission documents should be spelled without a hyphen,
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following The Associated Press Stylebook and Libel Manual.

Try not to split Internet addresses across two lines. If you need to, put the website
address on a separate line, centered. Or if the URL is still too long, reduce the point size.
For example:

http://www.energy.ca.gov/2007publications/CEC-180-2008-001/CEC-180-2008-001.PDF
http://www.energy.ca.gov/2007 _energypolicy/notices/2007-08-

16_workshop_notice.html

Italics

Italicize the name of all books and reports. For example, use 2007 Integrated Energy
Policy Report and 2008 Energy Policy Report Update. Do not underline. If the information
cited is from a magazine, put the article title in quotations and the magazine name in
italics.

Use italics, not quotation marks, to introduce new technical terms. Include such terms in
a glossary, if appropriate.

Language of Report

When writing the report, use American, not British, English.

Legislation
(Referencing Legislation in Energy Commission
Documents)

For consistency, the following format should be used when referencing all legislation in
reports or other documents:

Bill # (Author, Chapter #, Statutes of “year”)
Examples: Senate Bill 1 (Murray, Chapter 132, Statutes of 2006)
Assembly Bill 32 (Nufiez, Chapter 488, Statutes of 2006)

After that first reference, reference the bill as an abbreviation (SB 1 or AB 32) unless it
has a formal title.

If a bill has a formal title, the first reference should include the formal title followed by
the bill information. For example:

Petroleum Industry Information Reporting Act (Senate Bill 1444, Holmdahl, Chapter
1055, Statutes of 1980)
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Global Warming Solutions Act (Assembly Bill 32, Nuilez, Chapter 488, Statutes of 2006)

After that first reference, reference the bill as a shortened title (PIIRA or whatever the
act is commonly called).

Numbers

In a list in linear text, use numbering (in parentheses) to indicate the order in which
tasks should be done, to suggest chronology or relative importance among the items, or
to clearly separate the items. For example:

When repairing the machine, the researchers (1) gathered the parts, (2) assembled the
subsystems, (3) connected the subsystems, and (4) conducted tests to establish baseline
performance.

When establishing the policy, the State considered (1) wind turbines, both old and new;
(2) energy conservation programs that encourage consumers to reap the benefits of off-
peak electricity; and (3) photovoltaic installations - including emerging technologies that
use thin-film materials - in regions with superior insulation.

Otherwise, do not use numbering, as in the following example:

There are three key drivers of natural gas prices: supply, demand, and storage capacity.
It may be clearer, however, to use numbered bullets instead of a list in linear text.

Here are other rules for numbers:

e Use numerals for 10 and above; spell out all numbers one through nine, EXCEPT
when identifying:

o Percentages (2 percent)

Dates (June 2, 2005)

Page numbers (page 6)

Chapter numbers (Chapter 4)

Energy increments (1 megawatt, 9 kilowatts)

Sentences that include a list of identical items, some of which are fewer
than 10 and some are more: “We ran 2 trials in April, 5 in May, and 14 in
June.”

o Table and figure numbers (Table 4, Figure 6)

o O O O O

¢ Always use commas in numbers that are five digits or larger: 12,400, 245,678.
e Insert commas in four-digit numbers when they are used in tables or columns.
e Insert commas in four-digit numbers when they are used in tables or columns.

¢ Commas are optional when four-digit numbers appear in text, unless needed to
make the number clear.
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e Never begin a sentence with a numeral, including a year. “The energy crisis began
in 2000,” NOT “2000 marked the year the energy crisis began.”

e Always use a zero before a fraction smaller than 1.0. Use 0.25, not .25.

e Treat related numbers alike:
Last year we sold 21,557,000 items; this year, nearly 23,000,000.

e Repeat the word million (billion, trillion, and so forth) with each figure to avoid
misunderstanding:
$5 million to $10 million (NOT: $5 to 10 million).

e Use the metric system (International System of Units, or SI) or English units -
whichever is most appropriate to the report. When referring to temperatures,
however, use Fahrenheit along with Celsius following in parentheses - for
example, 212°F (100°C). There should not be a space between the temperature,
the degree symbol, and the letter. For executive summaries, use both SI and
English units of measurement, to support a greater understanding by a lay
audience. Use of other standard English measures (for example, acre-foot, two-
by-fours) is always appropriate.

Page Breaks

If a subheading is at the bottom of the page, but the text jumps to the next page, put a
page break before the subheading. Including a page break will ensure that headings are
not left alone at the bottom of a page with no content if the Word file is opened on a
different computer.

Percentages

Always spell out the word “percentage” instead of using the % symbol except when used
in a chart or graph. For example:

e The U.S. Labor Department reported that September unemployment rate fell 0.2

percent.

e The sales tax rate in California can vary from 7.0 to as much as 8.5 percent. Fifty
years ago, the tax rate was 2.5 percent. It increased to 3.5 percent four decades ago.
It has never gone down.

e [t is permissible to use the % symbol in graphs and charts.

Punctuation

Brackets

Use brackets for parenthetical material within parentheses. (Within the parentheses,
separate the text [parenthetical material] from the rest of the sentence.)

Colon and Semicolon

Use only one space (not two) after a colon or a semicolon.
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Commas

Use a serial comma style throughout the report.
Example: The research team tested the first, second, and third models.

Note: The comma after “second” is called the serial comma and separates the terms in a
simple series.

In a serial list that has multiple units in each element of the list, use a semicolon instead
of a comma to clarify groupings.

Example: The breakfast menu items were coffee, tea, fruit juice, or milk; bacon and
eggs; cold cereal and milk; hot oatmeal with cinnamon, apples, and cream; assorted
sweet rolls; or fresh fruit and yogurt.

Use commas to set off the main elements in an address or a title following a person
name.

Example: The Energy Commission has been located at 1516 Ninth Street, Sacramento,
California, for more than 20 years.

Example: Mary Jones, director of the project, is in charge of the contract.

Commas in Dates

Do not put a comma between a month and a year (July 2007), but do put a comma
between a date and the year and after the year if in a sentence.

Example: The Declaration of Independence was signed on July 4, 1776, in Philadelphia,
Pennsylvania.

Note: Use the standard American method of dating of month, date, and year.

Hyphen (-), En Dash (-), Em Dash (—)
When in doubt about whether to hyphenate a word, look it up in the dictionary or the

Gregg Reference Manual. Words with the prefix “non”, “anti”, “pre”, “pro”, “multi”, “co
are not hyphenated, except when “non” is used with a proper noun, such as non-English.

Words with a prefix that ends in the same letter as the root word are hyphenated.
Example: She suffered from a pre-existing condition.

Use for any set of words you want understood as one unit, but use them sparingly.
Example: It was an out-of-date idea.

Use to join compound modifiers, unless one of the words is an adverb ending in “-ly.”
Compound modifiers are two or more adjectives or adverbs that, if used separately, do
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not describe the word they modify:

e The utility offers consumers many energy-saving ideas.
e She was a newly elected senator. (“-ly” adverb, no hyphen)

Use an em dash (—) between a range of numbers. From the Insert Menu, select Symbol >
Special Characters > em dash.

Use an en dash (-) instead of a double hyphen (- -). Add a space before and after the en
dash. From the Insert Menu, select Symbol > Special Characters > en dash.

Percentage Symbol

Spell out the word “percent” if there is only a single reference to a percentage.
Example: The state and local sales tax in the area was 7.75 percent.
If there are multiple references within a sentence or paragraph, do not use the % symbol.

It is permissible to use the % symbol in graphs and charts.

Period Spacing

Use a single space after a period. Do not double space. If you have used double spaces,
use the find and replace function in Word to find double spaces and replace them with
single spaces.

Quotation Marks (“ ”)
Use around titles of chapters, sections, article titles, or a coined word or phrase.

e We read the chapter “Progress in Energy Programs,” from the Energy Efficiency
Report: 1998.

e The staff reviewed the “widget” design.

Please use period and commas inside quotation marks.

References Within the Report Body

When referencing a report, book, or other document within the body of the report, use
the format as described in The Chicago Manual of Style, 16th Edition.

Referencing is referring someone to the source. References (also called "citations") show
the reader what different aspects of your work are based on. Insert the reference in
brackets to lead the reader to information about the page of a book or other source that
is the evidence for what you have said.

For example: When you see a reference, like this: (Robinson, C.E. 2015 p.23), in the text
of a report, it means that you are being referred to page 23 of a book written by C.E.
Robinson in 2015. To find out the title and publisher of the book, you look in the
bibliography.

64



Special Characters and Symbols

Microsoft Word has a listing of special characters that you can use when typing. To view
the special characters, go to Insert > Symbol. These special characters make use of the
“Symbol” typeface that comes with and is installed by Microsoft Word. These special
characters are the same across computer platforms. For symbols that are not in the
standard typeface or font family, please contact Media and Public Communications
Office to discuss using them in a report.

Underlining

Do not use underlines. Use bold or italics.

Do not use underlines to differentiate a header or section. Use the style setting for that
heading.
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CHAPTER 7:
Word Use and Misuse

The following words are those most misused in Energy Commission documents. For
more information on usage, check The Gregg Reference Manual or To the Point.

accessible/assessable - A location is wheelchair accessible. A house is assessable by the
county tax collector.

additionally - also; and; as well; besides; beyond that (this) even; further; furthermore;
moreover; more than that (this); still more; then; too; what is more.

adopted, approved, passed, enacted - Amendments, ordinances, resolutions, and rules
are adopted or approved. Bills are passed. Laws are enacted.

adviser, advisor - The California Energy Commission uses a Public Adviser, not an
advisor, but the Commissioners have advisors.

affect, effect - “Affect” is a verb that means to change or influence. “Effect” is typically
a noun that means the result.*

Correct: The oil spill affected marine life for months afterward.
Correct: The effect of the oil spill on marine life was devastating

Although “affect” can be a noun, we hardly ever use it at the Energy Commission.
“Effect” can also be a verb, but we rarely use it.

aid, aide - Aid is assistance. An aide is someone who serves as an assistant.
airborne - spelled with an “e” at the end.

air quality management plan/district - Use lower case unless referring to a specific
plan or a specific agency.

approximately - about, around, close to, more or less, near, nearly, or so, roughly, say,
some.

assistance - aid, help, succor

assure, ensure, insure - “Assure” means to promise. “Ensure” and “insure” are often
used interchangeably, but use “ensure” for more general meanings for “to make
certain.” Reserve “insure” for legal and financial matters.

back up/backup - Use “back up” when it is a verb. For example: They will need to back
up their computer in case of a power failure. Use “backup” when it is an adjective or a
noun. For example: The backup generator has failed.
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baseload - one word, not two words.

because of, due to - Use “because of” to match cause to effect. “Due to” is an adverb,
which can be used when preceded by a linking verb. See examples.

Correct:

Because of the lower efficiency of the plants, which makes them less competitive, some
parties remain concerned that a significant portion of these plants would be retired in
the near future.

Some parties are concerned that a significant portion of these plants would be retired in
the near future due to the lower efficiency of these plants that makes them less
competitive. (Although correct, please note how this sentence is wordy and lacks
emphasis.)

Incorrect:

Due to their lower efficiency, some of these plants are less competitive, and some
parties are concerned that a significant portion of these plants would be retired in the
near future.

before - Use “before,” not “prior to.”
benchmark - one word, not two words.

BLM - The U.S. Bureau of Land Management prefers “the BLM” when using the acronym.
Always spell out upon first use.

brand names - Do not use brand names to describe a process unless that process is
being used. The same is true for other common brand names, such as Scotch® tape,
Kleenex® tissues, and Coke®. Always capitalize brand names.

brief (concise, short, succinct) summary or synopsis - Just say “summary” or
“synopsis.” Adding one of the adjectives listed would be redundant.

Cal/EPA - California Environmental Protection Agency uses a slash between Cal and EPA
in its acronym.

call into question - challenge, contradict, dispute, doubt, question.

Cal/OSHA - The acronym for Department of Industrial Relations Division of
Occupational Safety and Health (DIR/DOSH), better known as Cal/OSHA.

capitol, capital - The word “capitol” refers to the buildings in, for example, Washington,
D.C., and Sacramento. The word “capital” means the city where the seat of government
is located. Do not capitalize it. Used in a financial sense, capital refers to money,
equipment, or property. For example:

e The State Capitol is located near the Energy Commission.
e The Energy Commission is located in the state capital.
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e They had the necessary capital to underwrite the project.

city - Do not capitalize unless the word “city” is a formal part of a city name. For
example:

Correct: The mayor of the city of Sacramento dedicated the new power plant.
Correct: The City of Industry has the word “city” as part of its formal name.

CO - Abbreviation for carbon dioxide. Spell out on first usage. The “2” should be in

subscript. You may need to increase the font point size for the subscript so it is
readable.

combined-cycle - “Combined-cycle” before a noun is a compound adjective that should
be hyphenated... For example: a combined-cycle power plant.

concurrently - as one; at once; jointly; together.

contractions - Do not use contractions in external Energy Commission reports, notices,
and letters.

contrary to - after all, apart (from).

currently - now, today. (Note: If sentence uses present tense, you may not have to use
the adverb.)

data/datum - “Data” is plural. “Datum” is the singular form.
effectuate - achieve, bring about, carry out, effect, execute, realize.

email - The word “email” is not capitalized unless it begins a sentence. The word should
not be hyphenated, according to The Associated Press Stylebook and Libel Manual.

emissions performance standards - Use lower case.

entitled - Use “title.”

environmental impact report/statement - Use lower case in all instances.
equally well - The word “as” is not needed between “equally” and “well.”
eventuality - event, occurrence, outcome, delete.

e Kodak should have prepared for this eventuality.
e Kodak should have prepared for this outcome.

expenditure - cost, expense.
facilitate - ease, help, promote, simplify
facility - bathroom, building, factory, hospital, jail, office, place, plant, prison, school.

farther, further - The two words are commonly interchanged, but there is a distinction
worth observing: “farther” serves best as a distance word, while “further” is best used as
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a time or quantity word. You can chase a ball farther than the other fellow; you pursue a
subject further.

FAX (all capitals) is the approved substitute for “facsimile transmission.”

federal - Capitalize “federal” only at the beginning of a sentence and for corporate or
government entities that use the word as part of their formal names, such as “Federal
Express” and “Federal Trade Commission.”

first introduced - introduced.

gas-fired - Hyphenate if attributive adjective. For example: A gas-fired power plant.
general public - Use just “public.”

gigawatt-hours - Use hyphen before the hours. Abbreviation is GWh.

given the fact that - because, considering, for, given, in that, since, when.

government - Capitalize “government” only at the beginning of a sentence and never
abbreviate it.

Governor - It should be capitalized at the beginning of a sentence, when used as a
stand-in formal title (“The Governor signed the bill....”), or before a governor’s name
(Governor Schwarzenegger signed the bill....”). Do not abbreviate in any usage.

historic/historical - “Historic” means important or momentous. “Historical” means
relating to the past. Both words use “a” and not “an.” For example: A historic event.

Homepage - “Homepage” is one word and is always expressed with a capital "H."

hopefully v. hope - “Hopefully” means in a hopeful manner. Use “hope” in most
instances.

however - The Associated Press Style Manual suggests that you not begin a sentence
with the word “however.” Although the Media and Public Communications Office
adheres to this principle in usage, it is one area where experts disagree. The Gregg
Reference Manual, for example, notes this disagreement and concludes that the writer
must determine where to place such a transitional expression.

imply, infer - “Imply” means to suggest; you imply something by your own words or
actions. “Infer” means to assume, to deduct, or to arrive at a conclusion; you infer
something from another person words or actions.

impact - A strong word, “impact” denotes a forceful impingement, a collision, a violent
communication of force. Often it is used when all that is intended is effect or influence,
as in this example: “One of the questions raised by the Mayor attack on the Governor is
its impact on their collaboration to give Sacramento an opportunity to vote on a new
charter this year.” If the term “environmental impact” is quoted from a report, then it

may be used in that context. Otherwise, “environmental effect,” “environmental
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damage,” or “affect the environment” are preferable.
importantly - Avoid by rephrasing.

Incorrect: More importantly, he paid for the damages.
Correct: What more, he paid for the damages.

Incorrect: With the breeze freshening, he altered course to pass inside the island. More
importantly, as things turned out, he tucked in a reef.

Correct: With the breeze freshening, he altered course to pass inside the island. More
important, as things turned out, he tucked in a reef.

in advance of - before.

in agreement with - according to, by, following, in keeping with, in line with, in step
with.

in excess of - above, better than, beyond, faster than, greater than, larger than, more
than, over, stronger than.

in force and effect - active, at work, effective, in action, in effect, in force, in play,
working.

in order that - for, so, so that, that.
in order to - to.
in place of - for.

in response to - after, because of, by, due to, following, for, from, in, out of, owing to,
through, with.

in short supply - meager, rare, scant, scarce, sparse.
in sufficient number or quantity - enough.

in terms of - about, as, for, as to, by concerning, for, in, of, on, regarding, respecting,
through, under, with, delete.

in the vicinity (of) - close by, close to, near, nearby.

initially established - established.

Internet - Internet is always expressed with a capital "L."

irregardless - “Irregardless” is nonstandard English. Use “regardless.”
is compliant with - complies with.

is subject to - depends on, hinges on.

it’s, its - Do not confuse “it’s” with “its.” “Its” is the possessive form of the third person,
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singular, neuter pronoun “it.” “It’s” is a contraction of “it is” or “it has.”

jargon - Do not use jargon in Energy Commission documents. The audience of your
document many not understand technical jargon, and street jargon may demean your
audience or your document.

KV - Abbreviation for kilovolt. Capitalize the V.

locality - area, city, district, locale, place, point, region, site, spot, state, town, zone.
MVA - Abbreviation for “megavolt ampere.”

MW - Abbreviation for “megawatt.”

megawatt-hours - Use hyphen before “hours.” Abbreviation is MWh.
memorandum of understanding - agreement.

methodology - method. When developing estimates of market size, data extrapolation
methodologies may be useful. When developing estimates of market size, data
extrapolation methods may be useful.

Note: When discussing a set of methods or procedures used, then “methodology” is
appropriate. If it only one method, use “method.”

minimal - brief, least, lowest, minor, not much, scant, short, slight, smallest.
minimize - decrease; lower; reduce.

mitigate - moderate, soften, lessen, reduce.

move forward - advance, continue, go on, happen, move on, occur, proceed, progress.

non- - Most words with the prefix “non-" are not hyphenated unless the base word
begins with an n, as in non-native.

NO - Acronym for oxides of nitrogen. The x is done in subscript. The term "oxides of
X
nitrogen" is different than nitrous oxide, which is laughing gas.

occur - “Occur” refers to an accidental or unscheduled event. “Take place” refers to a
planned event. An accident cannot "take place," nor can a business meeting “occur.”

off site - Predicative adjective. For example: The meeting is located off site.
off-site - Attributive adjective. For example: It is an off-site location.

on a regular basis - bimonthly, biweekly, daily, hourly, monthly, regularly, weekly,
yearly.

ongoing - All one word. For example: The discussions were ongoing.

online - For Internet items, all one word. Do not hyphenate.
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on-line - For a power plant that is connected to the grid and produces power or a
transmission line or tower, use a hyphen. For example: The power plant is on-line.

open to the public - public. "The Energy Commission business meeting is public."
operational - active, live, running, working.

over - “Over” means physically above. If you mean a greater amount or quantity, use
“more than.”

owing to the fact that - because, considering, for, given, in that, since.

percentage point (unit) - Say “point.” Example: The U.S. Labor Department reported that
the September unemployment rate fell 0.2 points, to 5.4 percent.

policy maker - “Policy maker” is two words, not one.
power plant - “Power plant” is two words, not one.
preventative - preventive.

principal, principle - “Principal” refers to someone who is first in rank or authority or
describes something that is first in rank or authority.

e He was the principal of the school.
e [t was the principal reason for the part failure.

“Principle” means truth, doctrine or rule of conduct, such as an uncompromising
principle of honesty.

prior to - Use “before.”
raise questions about (on) - challenge, contradict, dispute, doubt, question.

ratepayer - “Ratepayer” is expressed as one word. “Bill payer” and other similar words,
however, are not.

regardless of the fact that - although, but, even though, still, though, yet.

remains to be seen - do not know, is not (now, yet) known, is uncertain, is unclear, is
unknown, is unsure.

right-of-way - Use hyphens between words. Plural is “rights-of-way.”

SF - Abbreviation for sulfur hexafluoride. The 6 should be in subscript.
6

simple-cycle - As a compound adjective, the term is hyphenated. For example: A
simple-cycle power plant.

split infinitive - There is a precedent since the 14th century for interposing an adverb
between “to” and the infinitive it governs; avoid the split infinitive unless the writer
wishes to place unusual stress on the adverb.
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Incorrect: to diligently inquire.
Correct: to inquire diligently

staff - “Staff” is a singular noun and requires a singular verb. It is also called a collective
noun, but it is used as a single unit.

Wrong: Staff are involved in the project.
Right: The staff is involved in the project.
Right: The staff members give regular updates and participate in briefings.

state - Capitalize when it stands in place of the “State of California” and is used as a
noun. Do not capitalize if used as an adjective.

Right: The State will consider adopting new regulations.
Right: The state employees were ready to bargain on their contact.

state names - Spell out the names of the 50 U.S. states when they stand alone in textual
material. Any state name may be condensed, however, to fit typographical requirements
for tabular materials.

statue and statutes - “Statue” is a likeness sculptured, modeled, or cast into a solid
substance. “Statutes” pertain to decree in law.

switchyard - One word, not two.

take into account - allow for, consider, provide for, reckon with, regard, weigh.
that is - delete.

Incorrect: This relates to the cost that is incurred by start-up firms.

Correct: This relates to the cost incurred by start-up firms.

there’s/there are - Do not use this contraction. In most instances, “there’s” will be a
subject-verb disagreement, and it will be misused.

Incorrect: There’s many ways to approach the problem.

Correct: There are many ways to approach the problem, but there’s only one correct
way.

time frame - Two words, not one word.

under - “Under” means physically below or underneath. If you mean a lesser amount or
quantity, use “less than.”

unique - Unique things are one of a kind. Don’t say “very” unique.

unproven - unproved.
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USACE - Correct full abbreviation for United States Army Corps of Engineers.

U.S. DOE - Correct full abbreviation for United States Department of Energy. “U.S.
Department of Energy” is also approved for first usage. Abbreviate as “DOE” afterward.

USFWS - Correct full abbreviation for United States Fish and Wildlife Services.
utilize or utilization - use.

we - Do not use first person (we, us, or they) or third person (they, them, their) in
reports, notices, or formal letters when referring to Energy Commission staff or the
State of California.

Webmaster - Webmaster is one word and is always expressed with a capital “W.”
website - The term is one word, lower case.
whether or not - if, whether

who - “Who” and “that” may refer to persons. Use “who” when referring to persons. Use
“that” when referring to groups, types, classes of persons.

which - “Which” and “that” refer to places, objects, animals, things, and others. Use
“which” for nonessential clauses. Set off the “which” clauses with commas. Use “that”
for essential clauses. Do not use commas.

Nonessential words, phrases, and clauses are not needed to complete the structure or
meaning of a sentence. Nonessential elements supply supplemental, parenthetical, nice-
to-know information.

Example: The report, which was completed and submitted on time, still requires
substantial revision.

Essential words, phrases, and clauses are needed to complete the sentence. They cannot
be removed from the sentence because they provide need-to-know information.

The report that the consultant submitted is complete, but the report that staff prepared
will need additional work.

you and I - The phrase should be “It’s between you and me.” It should not be “It’s
between you and I.” “Me” is correct because it is the object of the preposition between. It
is correct to say, “You and I are going to the store.”
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CHAPTER 8:
Energy Commission Staff Papers

A staff paper is a type of Energy Commission publication usually written to discuss one
topic, or it could be a paper written for an academic periodical or journal, or it can be a
paper presented at a conference.

Staff papers are generally short (fewer than 25 pages) and may be written in a less
formal style than a report. Staff papers sometimes are written as a supporting
document to a larger report. They are additionally written on “state time” as opposed to
the staff member’s personal time.

Staff papers, however, go through the same review and sign-off process as regular
Commission staff reports.

Papers written by Energy Commission staff for an academic journal or a professional
organization (such as the Society of Automotive Engineers or Society of Heating
Refrigeration Air Conditioning Engineers) or presented at a conference, symposium, or
other event may use the formatting required by that conference or publication.

The Energy Commission will also “publish” the paper itself by making it available on the
Commission website. Add a staff paper cover to that document (with no credits page).

Papers of this type also go through a review and sign-off process before being published
by the journal or professional organization, but the editing process is less rigorous than
for Commission reports.

You may need to get copyright permission from the publisher of the paper so the
Energy Commission can post the paper on its website. Please contact Media and Public
Communications Office if you have questions.

Staff papers other than those mentioned above, use the same style formatting as a
regular Energy Commission report with the following exceptions:

e The document uses a staff paper cover.
e There is no credits page. Credit information is included on the cover.

e The staff paper has a specific disclaimer that is included on the cover of the
paper as seen in Figure 11.

75



Figure 11: Cover of Staff Paper

STAFF PAPER

Title of Report, Using
“Cover Page Title” Style. Use
No More Than Three Lines

Author(s) Name(s)
Office Name

Division Name

California Energy Commission

Source: California Energy Commission, Media and Public Communications Office

The required parts for of the cover for staff papers are:

Title of paper (Lucida Bright font 29 pt., bold, Title Format).

Type of report: Staff Paper (Lucida Bright font 20 pt., bold, ALL CAPS).
Author name in bold, title case (Lucida Bright, gray, 18 pt., bold).
Office name (Lucida Bright 16 pt., normal).

Division name (Lucida Bright 16 pt., normal).

California Energy Commission (Corbel 12 pt., italic).

Disclaimer.
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CHAPTER 9:
Energy Commission Presentations

The business world and government agencies have become enamored with Microsoft
PowerPoint presentations. Using PowerPoint should not be a deterrent to a good
presentation. Nor should a presenter simply read the bullet points to the audience.

Peter Norvig created a humorous look at how absurd a PowerPoint presentation can be.
He took Abraham Lincoln Gettysburg Address and put it into a slide show.5

5 http://www.norvig.com/Gettysburg/index.htm - used with permission.
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Figure 12: The Gettysburg Address as a PowerPoint Presentation

Gettysburg Cemetery
Dedication

Abraham Lincoln

119186

Not on Agenda!

= Dedicate
= Consecrate
= Hallow
(in narrow sense)
= Add or detract
= Note or remember what we say

o

Organizational Overview

[mNew Nations|

198

2

= Met on battlefield (great)
= Dedicate portion of field - fitting!
= Unfinished work (great tasks)

11863

Review of Key Objectives
& Critical Success Factors

= What makes nation unique
— Conceived in Liberty
Men are equal
= Shared vision
— New birth of freedom
Gov't offfor/by the people

10101863

= New nation

= Civil war

= Dedicate field

= Dedicated to unfinished work
= New birth of freedom

= Government not perish

1101863

Norvig says, “PowerPoint also ‘lowers the ceiling’; it makes it harder to have an open
exchange between presenter and audience, to convey ideas that do not neatly fit into
outline format, or to have a truly inspiring presentation.”

Edward Tufte is considered by many to be one of the most astute proponents of good
graphic design. In his essay6 in Wired magazine, September 2003, titled “PowerPoint Is
Evil - Power Corrupts, PowerPoint Corrupts Absolutely,” Tufte says:

6 http://www.wired.com/wired/archive/11.09/ppt2.html
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“About 80% of the deep problems with PowerPoint (PP), however ... is [the] inherent
defect in slide ware: low resolution, replacing sentences with grunts, relentless
sequentiality, and so on through the rest of the problems. About 80% of my essay could
just as well be called The Cognitive Style of Slideware: Pitching Out Corrupts Within.

“Consequently, slide ware redesigns are largely futile exercises; solutions for serious
technical reporting are found in good technical reports, not in the interior redecorating
of slides. My essay is largely about what happens to the quality of evidence and analysis
when passing through slide ware. Patches for PP and slide redesigns by commercial
artists cannot solve those problems for technical reports.

“All history of improvements in human communication is written in terms of
improvements in resolution: to produce, for viewers of evidence, more bits per unit
time, and more bits per unit area. Slide ware is contrary to that history. Trading in
reductions in resolution for user convenience or for pitching may useful in mass market
products or in commercial art, but not for technical communications. The solution is
not to rescue slide ware design; the solution is to use a different, better, and content-
driven presentation method.

“After years of boredom with speakers using PP and reading their boring slides to me, I
did something kind of strange this past fall. I made a presentation with no text. I made
handouts with my stats in legible and understandable charts that people could refer to
during the talk and take home later. I only had images on my slides .... Then I talked,

using the images to support and illustrate my message. No charts, no words, no bullets.

“Four months later I'm still getting email from people who were in the audience saying it
was the most memorable presentation they'd seen all year. Funny thing is, I'd given the
same talk with a screen full of text and hadn’t gotten any reaction by email at all.

“I'm going minimal from now on.”

The Energy Commission suggests visiting Tufte website7 for more insights. Especially
thought provoking is an analysis of the space shuttle Challenger disaster, which Tufte
says may have been avoided if a presentation on concerns about launching in cold
weather was not done in PowerPoint. See

http://www.edwardtufte.com/bboard/q-and-a-fetch-
msg?msg_id=0001yB&topic_id=1&topic=Ask+E.T.

7 http://www.edwardtufte.com

79


http://www.edwardtufte.com/bboard/q-and-a-fetch-msg?msg_id=0001yB&topic_id=1&topic=Ask+E%2eT%2e
http://www.edwardtufte.com/bboard/q-and-a-fetch-msg?msg_id=0001yB&topic_id=1&topic=Ask+E%2eT%2e
http://www.edwardtufte.com/

Other websites offer additional information about making good presentations. Also see:

http://www.boxesandarrows.com/view/understanding_powerpoint_special_deliverable_
5

http://www.beyondbullets.com

Even with these admonitions, we realize that Energy Commission staff will need to
create slideshow presentations. PowerPoint templates are available on “EnergyNet” to be
used for presentations at:

http://energynet/Exec/doc_production/index.html

The first slide of presentation should contain the following elements:

Clear title of presentation
Presenter name(s), office, and division
Date of presentation

Name (title of conference, for example) and location (city) where presentation

was given

e Energy Commission seal (on all slides - it is included on the mater slide
template)

e Program area logo (if applicable)

Presentation files should be sent (in PowerPoint and Acrobat PDF®) to the Webmaster to
be placed online, either as part of a proceeding documents page or available via the
website publications database. Please see Chapter 12 on submitting files.

Putting Presentations Online

All public presentations made at Energy Commission hearings or workshops, or made at
conferences or professional seminars should be available on the Commission website.
The office manager and division chief should review staff presentations. Please see Page
21 for the review and publication process for presentations.

Most presentations connected with specific workshops or hearings are listed on a
proceeding documents page on the Energy Commission website. Presentations,
speeches, or testimony given by commissioners, division chiefs, or staff to legislative
hearings, to conferences, or academic seminars are given a Commission publication
number and are entered into the publications database.
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CHAPTER 10:

Required Elements for Fact Sheets,
Brochures, Posters, and Other Types of
Printed Materials

Brochures, fact sheets, posters, and all other printed materials must go through the
Energy Commission review and sign-off process.

All printed materials are required to have the following elements:

Commission publication number
Month and year of publication
Commission seal

Governor’s name

Commissioner stack (as of July 2015) in the following order:
California Energy Commission

Robert B. Weisenmiller, Ph.D.
Chair

Commissioners
Karen Douglas, J.D.

Andrew McAllister
David Hochschild
Janea A. Scott

Please contact the Media and Public Communications Office first before beginning a
poster, fact sheet, technical brief, flyer, or brochure.

If you have a technical support contract for creating such documents, please have the
contractor contact the Media Office before beginning work so that staff can make sure
the contractor is aware of all the requirements.
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CHAPTER 11:
Submitting Files to the
Media and Public Communications Office

The Energy Commission uses the Microsoft Office suite of software programs for word
processing, spreadsheets, and presentations.

When submitting reports to the Media and Public Communications Office, please send
all files relating to the document, including original figures and graphic files. That way;,
the Energy Commission will be able to replicate the document in the future or convert it
into future publication formats (such as XML) as technology changes.

Word and PDF Files

Send copies of the full documents as Microsoft Word .doc files. These may be combined
into one file or sent as separate files. Appendices should be sent as .doc files as well. Do
not save as .docx files in Windows 7.

When saving the file, please make sure that the copy has all tracked changes accepted
into the final version, unless it is undergoing further editing.

Convert all Word files into Acrobat Portable Document Format (PDF) files.

Do not password protect or encrypt Word documents or PDF files.

Document Properties

The properties of the file must be filled out in Word and in the PDF. Go to File >
Properties menu in either program and complete the information in the summary or
description portion. The areas that must be filled out are:

Word Properties

Acrobat Properties

% Title < Title
% Subject % Author
< Author % Subject
% Manager % Keywords
< Company (Calif.

Energy

Commission)
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< Category
(optional)

< Keywords

<+ Comments
(optional)

File names should be descriptive of the report. So, when the Word file is sent to the
Energy Commission, it can be named anything as long as it is descriptive. The file name
for the Word and PDF files will eventually be given the publication number of the report
or appendix. For example, CEC-180-2015-001.PDF is the file name for the PDF file for
this Style Manual.

You should also set the properties of a PDF file so that the file fits the computer screen.
This is set under the Acrobat Document Properties - Initial View. Set the page layout to
“single page.” Set the magnification to “fit page.”

Graphics and Figures

The author must send a copy of all graphic files used in the report along with the final
document file. These files should be sent to the Energy Commission Webmaster on a
CD-ROM if they cannot be sent easily via email.

The following are things to remember regarding graphics, photographs, and images of
figures.

e Embed the graphic in the report document, but also save each file separately
from the main report.

e Save photos in their original or raw digital format (if available) as well as in JPG
or PNG. Do not use TIF or GIF files unless forced.

e If a photo is manipulated to change contrast or fix elements, save files in Adobe
Photoshop® PSD format (please include layers if used) and in JPG or PNG
formats. Please make a notation that photo was manipulated and what was done.

e Save illustrations and graphic elements in their original format such as Adobe
Mlustrator, Adobe InDesign, or Macromedia Freehand.

e Graphics and photographs should be saved at a higher resolution, at least 300
dots per inch (dpi). Do not use lower-resolution (72 or 96 dpi) graphics that are
found on websites, as they do not reproduce well in printed documents.

e Label graphic files names so they correspond with their figure title in the report.
For example, if you have a photograph used as Figure 23, label the file name as
figure_23.jpg.

e Use underscores (_) between words in file names instead of spaces.

e Do not use the following characters in a file name: ! @ # $ %A &* () :;{}[]1/\l

Please note that Energy Commission publications are in the public domain because they
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are funded by public money. As such, photographs or other graphic files also are in the
public domain. The Energy Commission reserves the right to use photographs or other
graphic files in other publications or on the Energy Commission website.

Accessibility of Documents in Word and PDF

The California Energy Commission websites must comply with American with
Disabilities Act regulations. These include Section 508 of the Federal Rehabilitation Act
of 1973, as amended (29 U.S.C. 794d); California Government Code Section 11135 (d) (1-
3); and State Administrative Manual (SAM) Chapters 4800-4833.

Because of that requirement, all PDF files will need to have informational tags
embedded within the document to alert screen readers about elements of the document.
This includes having images tagged, paragraphs ordered for screen readers (especially if
using two-column design), and other elements.

Please contact the Webmaster for information about making sure that the elements in
PDF files are properly tagged and encoded.
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CHAPTER 12:
Use of the California Energy Commission
Seal

The California Energy Commission seal may not be used on documents without
permission.

The seal is used by the Energy Commission to indicate official information and/or
official Commission publications. If it is used by other entities, it could be construed as
an endorsement of a product or process, and the Commission and the State of
California cannot provide such endorsements. The seal should also not appear on any
website other than ones hosted and maintained by the Commission.

The Energy Commission is aware of statements in marketing literature stating or
implying Commission “approval” of products or services. The Energy Commission does
not endorse, favor, or recommend any particular product or service. Moreover,
California law states that:

“It is unlawful for any person, firm, corporation, or association that is a
nongovernmental entity to ... solicit the purchase of or payment for a product or service
... by means of a mailing, electronic message, or Internet website that contains a seal,
insignia, trade or brand name, or any other term or symbol that reasonably could be
interpreted or construed as implying any state or local government connection,
approval, or endorsement ....”

California Business and Professions Code, Section 17533.6.

Occasionally, the Energy Commission seal is used on banners or posters for workshops,
meetings, or conferences where the Commission is a sponsor or cosponsor. Or there
may be another reason for the Commission seal to appear on project-related items.

Those uses require approval by the Energy Commission Media and Public
Communications Office before a product is created. Draft versions of such documents
will need to go through the approval/review and sign-off process.

If you have a question about the use of the Energy Commission seal, please contact the
Media Office at 916-654-4989.
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APPENDIX A:
Common Editor / Proofreading Marks

Symbol Example Meaning
?\_' weeke/F delete letter, word, phrase
A febA[Jary insert
| # power/plant insert space
s closé Up close up
Sp. 1st spell out
e fuIIAtime insert hyphen
LC B make letter lowercase
Z .4 make letter lowercase
— b make letter uppercase
™ :s’cﬁgy transpose letters, words
(2% Pl insert period
/,\ members,,\who insert comma
P end. In the start new paragraph
STET final report let it stand (ignore mark)
ital Time Magazine change to italic

B orbold  Figure 125 change to bold
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